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ACCORD DE LICENCE LOGICIEL  

IMPORTANT - LIRE ATTENTIVEMENT  
Ceci est un accord légal entre l’utilisateur (une entité individuelle ou unique) et Timestone Software. En conservant 
ce package et en utilisant le logiciel, vous acceptez les limites de cette licence. Si vous ne souhaitez pas accepter les 
termes de cette licence, vous êtes priés de renvoyer rapidement toutes les copies du logiciel, les guides utilisateurs et 
les systèmes de protection (dungle) pour un remboursement complet. Ce guide utilisateur et les logiciels Timestone 
sont protégés par les droits d'auteur. Timestone est une marque déposée. En acceptant cette licence, vous avez le 
droit de les utiliser, dans les limites de cet accord. 
 
Définitions et interprétation  

• Le logiciel signifie les modules de programme disponibles et autorisés dans le cadre de votre installation. 

• Le dispositif de Hardlock signifie le dispositif de protection utilisé pour permettre au logiciel de 
fonctionner. 

• Portée de l’accord. 

• Timestone Software autorise l'acheteur initial, l'utilisation personnelle et non-exclusive du Guide utilisateur 
et du logiciel sujet aux modalités et aux conditions de cet accord. 

• Porté de la licence. Vous pouvez utiliser ce logiciel sur un maximum d'un ordinateur. Vous pouvez 
transférer le logiciel d'un ordinateur à l'autre à condition de ne pas permettre l'utilisation du logiciel sur plus 
d'un ordinateur à la fois. 

• Copies. Vous ne pouvez pas copier ou reproduire ce logiciel, excepté dans un but d’archivage, de 
vérification des erreurs de programme, ou pour substituer des supports de stockage défectueux. Vous ne 
pouvez pas modifier, décompiler ou désassembler le logiciel. 

• Transferts. Vous ne pouvez louer ou prêter le logiciel dans le cadre de cet accord. Vous pouvez transférer le 
logiciel (ainsi que toutes copies de sauvegarde), le dispositif de protection par dongle et le guide utilisateur 
sur un serveur permanent à condition que vous ne mainteniez aucune autre copie, l’utilisateur accepte d’être 
lié par les limites de cet accord, et Timestone Software peut autoriser le transfert après confirmation écrite. 

• Limite. La licence accordée dans cet accord est effective jusqu'à son échéance. Vous pouvez la rompre à 
tout moment en détruisant ou en renvoyant à Timestone Software le logiciel et le guide utilisateur, ainsi que 
toutes les copies, et le dispositif de Hardlock (dongle). Si vous ne vous conformez pas aux termes de cet 
accord, cette license se terminera et, vous acceptez de détruire ou renvoyer à Timestone Software le logiciel 
et le guide utilisateur, ainsi que toutes les copies, et de retourner à Timestone Software le dispositif de 
Hardlock. 

Limite de Garantie, Déni  
Timestone Software garantie que le logiciel et le medium sur lequel le logiciel et le guide utilisateur sont installés 
sont sans défaut pour une utilisation normale pendant une période de 90 jours à compter de la date de votre achat. Le 
logiciel est vendu "tel quel", et vous assumez l'entière responsabilité concernant sa qualité et ses performances. Il est 
de votre responsabilité de vérifier les résultats obtenus à partir de l'utilisation du logiciel. 
 
Si pendant les 90 jours de garantie, vous découvrez des défauts physiques sur le guide utilisateur ou sur le medium 
contenant le logiciel, Timestone Software les remplacera gratuitement. 
 
DANS AUCUN CAS TIMESTONE SOFTWARE NE POURRA ETRE TENU RESPONSABLE POUR 
TOUT DOMMAGE DIRECT, INDIRECT, FORTUIT, MÊME SI  TIMESTONE SOFWARE A ÉTÉ 
INFORMÉ DE LA POSSIBLILTE DE TELS DOMMAGES. 
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1 
Avant de commencer…  

 
Portée et assistances  

Ce manuel couvre les aspects techniques exigés pour utiliser NeoPack+. Ce manuel est divisé en plusieurs 
parties. Les utilisateurs ‘basics’ doivent se référer au chapitre ‘Utilisation’', tandis que les utilisateurs 
‘avancés’ doivent se référer au chapitre `références techniques'. 
 
Obtenir plus d'aide  
Plus d'aide est disponible pour NeoPack+ aux endroits suivants : 

• Système d'aide en ligne de NeoPack+,  

• Aide sur les pages de notre site web (anglais) : http://www.timestone.com.au, 

• Support technique comme défini à la fin de ce chapitre. 

Conditions de pré installation  
Vous aurez besoin des ressources suivantes avant de débuter l’installation de NeoPack+ : 

• CD-Rom d’installation du logiciel NeoPack+, 

• Le guide de l'utilisateur du logiciel NeoPack+, 

• Dispositif de protection de matériel (dungle),  

• Le code de dévérouillage fourni par Timestone Software, 

• Que votre ordinateur est conforme aux spécifications techniques décrites au chapitre 2 ‘installation 

de NeoPack+’. 

Apprendre NeoPack+  
Les ressources suivantes sont incluses sur le CD-Rom de NeoPack+ : 

• Fichiers d'installation  

• Manuel d'utilisation de NeoPack+ - le document que vous lisez actuellement. 
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Obtenir l'aide du support technique. 

 
Nous offrons différentes méthodes de support. Cependant, nous vous encourageons fortement à utiliser 
l'email.  
 

 

 

Support téléphonique  
Le support de téléphone est disponible en appelant Timestone Software pendant nos heures 

d’ouvertures : 

De 9h00 à 17h00  (-10h en Australie) 

Le numéro de téléphone est : 

+ 61 3 9570 9899  

 
 

 

Support par fax  
vous pouvez nous envoyer vos questions par fax au support technique. 

Le numéro de fax est : 

+ 61 3 9570 9855  

 
Support par E-mail  
Il existe des pages de support avec des liens sur la dernière version du logiciel, et sa documentation, 

vous y trouverez aussi une rubrique FAQ. 

Nos coordonnées sur le web sont : 

http://www.timestone.com.au 

mailto:support@timestone.com.au 
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2 
Configuration système 
 

Configuration système  
La configuration minimale suivante est exigée pour que NeoPack+ fonctionne.  

Configuration minimale  
• Processeur Pentium II Intel à 350 Mhz  

• carte mère à 100 Mhz  

• 128 Mo de RAM  

• carte vidéo 4Mo (1024 x 768 @ 24 bits - voir la note)  

• disque dur 9Go (voir la note)  

• carte Ethernet 10/100 

• modem 33.6k  

• moniteur couleur Haute Définition (Sony, Apple) 17 "  

• Windows NT 4.0  SP 3   

• Souris avec mouse wheel (Microsoft, Logitec)  

En option : 

• tablette graphique 6 x 9 (Wacom)  

• Graveur Cd-r ou DVD pour la sauvegarde de données  

Notes  
Carte vidéo : 
Il est important d'utiliser une carte vidéo haut de gamme, qui permette l’étalonnage du moniteur. 
Typiquement, des marques comme ATI ou Vidéo Seven proposent de tels produits. 
 
Disque dur : 
Si vous utilisez NeoPack+ en monoposte, et que vous voulez qu’il fonctionne très rapidement, stockez 
toutes vos images sur une pile de disques en RAID SCSI.  
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3 
Installation De NeoPack+  
 

Ouvrir le CD-Rom dans l'explorateur Windows, et double cliquez sur le fichier Install de 
NeoPack+. L'écran d'installation apparaît. 

 
Le processus d'installation peut exiger un redémarrage du système. Dans ce cas l'installation ne sera 
terminée qu’une fois l’ordinateur redémarré. Appuyez sur Next pour valider. 

 

Lisez le contenu de l'écran ReadMe. Il contient des informations qui peuvent être exigées pour 
l'installation.  Appuyez sur Next pour valider. 

 
Choisissez le dossier d’installation du programme. Appuyez sur Next pour valider. 
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Le programme vous propose de créer les fichiers de sauvegarde, validez.  Appuyez sur Next pour 
valider. 

 
Choisissez les composants à installer. Si cette machine héberge les dongles, vous devez installer le 
composant Hardlock device driver. 
 
La documentation et les fichiers d’aide sont installés dans le même répertoire que celui du 
programme.  Appuyez sur Next pour valider. 

 
Choissez un nom dans le gestionnaire de programme pour ajouter les icônes de Timestone.  
Appuyez sur Next pour valider. 
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Une fois que vous êtes satisfait de votre configuration, Appuyez sur Next pour la valider ou Back 
pour la modifier 

 
L’installation commence. 

 
Une fois que tous les fichiers ont été copiés, l'écran Complete s’affiche. Choissez Finish pour 
terminer l'installation. 
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Installation de Adobe Acrobat Reader. 
Si vous voulez visualiser les documentations fournies par Timestone, vous devez installer Adobe 
Acrobat Reader. Si vous n'avez pas ce logiciel sur votre système, utilisez l'installateur qui est 
préqent sur le CD. 
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4 
Licence Serveur  

 
Les logiciels Neo de Timestone sont protégés contre l'utilisation illicite par le licence Serveur. Il s’agit d’un service 
de Windows NT, qui est installé sur un serveur ou un poste relié au réseau. Il se compose de plusieurs parties : 

• Un hardlock ou dongle qui est relié au port parallèle du serveur, 

• Le Licence Serveur, installé seulement sur le poste qui sert de serveur d’impression, 

• Le Licence Manager qui est installé sur le serveur, ou sur un poste relié au réseau, 

• Plusieurs fichiers d’aides. 

 

Comprendre le Licence Serveur 
Une fois que vous avez acheté une application Neo à Timestone Software, vos ordinateurs sont équipés d’un 
hardlock ou dongle. Ce hardlock contient un code spécifique pour votre installation. Sans lui, il vous est impossible 
d'utiliser le programme. 
 
Il est possible d'acheter une licence simple ou multi-utilisateurs. Quand une nouvelle licence est installée, elle 
s’ajoute automatiquement au Licence Serveur. Vous pouvez ainsi utiliser toutes les licences que vous avez acquises. 
 
Installation du Licence Serveur  
A l’installation de l’application Neo, choisissez le composant License Serveur. Le Licence Serveur sera alors 
installé. 
 

# Il suffit d'installer le Licence Serveur sur la machine qui accueillera le hardlock. Il vous sera demandé de 
relancer le PC. 

 
Une fois que le PC a été relancé, vous noterez plusieurs choses : 

• Un nouvel icône Licence Serveur a été ajouté dans le panneau de configuration,  

• Un nouveau service, Timestone Licence Serveur a été ajouté à la liste des Services Windows, 

• Un nouveau programme, Licence Manager a été ajouté au menu Démarrage > Timestone Software. 

Reliez maintenant le hardlock au port parallèle du Licence Serveur.  

 
Configurer et tester le Licence Serveur 
Le hardlock peut être relié à n'importe quelle machine sur  le réseau local. Cette machine ne doit pas héberger 
d’application Neo pour pouvoir jouer le rôle de hardlock serveur. 
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Hardlock et installation du Licence Serveur  
Assurez vous d’abord que le hardlock est branché au port parallèle du serveur. Exécuter l'installation de l’application 
Neo, en vous assurant que les composants Licence Serveur et Support Files  sont cochés. Il n'est pas nécessaire de 
cocher l'application Neo si cette machine ne fait qu’héberger le License Serveur. Le programme d’installation va 
redémarrer l’ordinateur. 

Configuration du Licence Serveur  
Ouvrir le panneau de configuration de Windows. Localiser l’icône Licence Serveur, et double cliquez dessus. 
Le panneau de commande du Licence Serveur s'ouvre. 
Indiquez le nom de l'ordinateur qui héberge le hardlock, et appuyez sur le bouton test. Le Licence Serveur contrôle 
la présence du hardlock sur le PC. Si il est correctement détecté, le panneau de commande affiche OK. Si une erreur 
apparaît, vérifiez les points suivants : 

• le nom d'ordinateur est correctement orthographié, 

• Le hardlock est relié au port parallèle du PC,  

• Le port parallèle fonctionne correctement,  

• Les composants Support Files et License Serveur ont bien été installés.  

Si vous recevez à nouveau un message d’erreur, contactez Timestone Software ou votre distributeur. 

 

Activer les licences  
Quand vous achetez une application Neo, vous achetez un droit d’utilisation. Timestone Software vous fourni alors 
un certain nombre de codes qui s’ajouteront dans le Licence Manager. Ces codes sont envoyés par Email, ou fournis 
sur le CDROM d’installation. Ces codes sont expédiés indépendamment du hardlock pour des raisons de sécurité. 

Ajouter les licences au Licence Serveur 
Assurez vous que le hardlock et le Licence Serveur ont été installés et configurés avec succès. 
Depuis le menu Démarrer, choisissez  Timestone Software > Licence Manager. Le Licence Manager s'ouvre. 
Faites bien attention aux messages d’erreurs affichées à l’étape précédente. Avant de débuter la configuration vous 
verrez peut-être un message du type Missing/empty license code table file.  Ce message disparaîtra une fois que 
des licences valides auront été installées. Si le message est du type Hardlock is invalid or missing, réinstallez le 
Licence Serveur. 
Si vous devez ouvrir le Licence Serveur Setup, cliquez sur le bouton setup au bas du Licence Manager. Le 
panneau de commande Licence Serveur Setup s'ouvre.  
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Choisissez l’onglet codes. Si aucune licence n'a encore été ajoutée, cette liste doit être vide. Toutes les licences 
précédemment installées doivent apparaître dans cette liste. 
Pour ajouter une nouvelle licence, cliquez sur le bouton Add file…. Une boite de dialogue s’ouvre. Vous devez alors  
sélectionner les codes qui vous ont été fournis, puis cliquez sur Ouvrir. Au bout d’un instant, la nouvelle licence 
apparaît dans la liste et devient disponible. 

 
Chaque nouvelle ligne dans la liste indique : 

• Le nom de l'application  

• Le numéro de version  

• Le nombre d'utilisateurs autorisés  

Si vous n’avez plus de licence à ajouter, la configuration est terminée. 
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Configurer les postes de ‘job’  
Une fois que le Licence Serveur est installé et que les licences ont été ajoutées, chaque poste de travail sur le réseau 
local doit être configuré. Le Licence Serveur a été installé sur chaque poste, en même temps que l’application Neo. 
Vous devez alors ouvrir le panneau de configuration et lancer le Licence Serveur Setup sur chaque poste qui 
utilise une application Neo, et le configurer comme au paragraphe précédent.  
Si une erreur survient vérifiez les paramètres suivants : 

• Le PC hébergeant le Licence Serveur est alimenté, et le Licence Serveur est correctement configuré,   

• Le PC hébergeant le Licence Serveur est relié au réseau,  

• Le poste de ‘job’ que vous configurez peut accéder au réseau, et en particulier au PC hébergeant le Licence 

Serveur. 

Fermer le panneau de configuration. L’application Neo peut maintenant fonctionner. 
 

Sauvegarde de votre configuration Licence Serveur 
Si vous voulez sauvegarder votre configuration, il suffit d’archiver le fichier suivant : 
\\Serveur\Program Files\Timestone Software\License\TsLServeur.lct 
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5 
Comprendre NeoPack+ 

 
NeoPack+ vous permet créer facilement une grande variété de produits grâce à une application puissante. Des 
produits tels qu’une collection d’image simple, des images placées dans des cadres graphiques, des produits clef en 
main comme des couvertures de magazine, des cartes d'identification et bien d'autres produits encore. 
Tous ces produits sont créés en utilisant un ‘template’ ; il est ainsi possible de créer des présentations complexes en 
quelques clics. Les ‘templates’ peuvent contenir un ou plusieurs types d’objets. Placez une image de fond, décidez 
où vos images doivent apparaître, puis ajoutez un texte. Vos images peuvent être arrangées en ‘packages’ pour être 
imprimées. 
Les images à imprimer dans NeoPack+ sont préparées rapidement à l'aide des palettes de correction.  Vous pouvez 
zoomer, couper, corriger la balance chromatique, travailler la densité ou le contraste. 
 

Caractéristiques principales de NeoPack+ 
Principe de rapports d’homothétie des ‘packages’  
NeoPack+ vous permet de visualiser les rapports d’homothétie correspondant aux formats 
de papiers. Vous  pouvez ajouter autant de format que vous le désirez. De même, vous 
pouvez créer les ‘packages’ contenant n’importe quelle combinaison de formats de tirages. 
Tout dépend de ce que votre imprimante est capable de manipuler comme tailles de 
papiers.  
 
� Nouveau dans la version 2.0  

A partir de la version 2 de NeoPack+ vous pouvez placer des images en noir et blanc ou virées dans un ‘package’. 

 

Images coupées 
Quand vous créez un ‘package’, il est important que vos images soient coupées correctement. NeoPack+ vous offre 
la possibilité de recadrer votre image à la souris. Lorsque vous créez un ‘package’, chaque vignette peut afficher des 
rapports d’homothéties, permettant de s’assurer que votre image est bien cadrée dans votre format de papier de 
sortie. 
 
Vous disposez du zoom et du positionnement de l’image en x et y. Ces commandes peuvent être ajustées depuis la 
boîte à outils, ou bien à la souris. Les images peuvent être coupées individuellement ou par lot. 
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Corrections des couleurs et de la densité  
Les couleurs et la densité  peuvent être modifiées dans la boîte à outils. Vous disposez d’une palette complète : 
Jaune, magenta, cyan, densité et contraste. 
 
Modification des images 
Les images peuvent être éditées directement dans un logiciel dédié (Photoshop®, ACD See®). L'ouverture est rapide 
et les modifications sont conservées dans Neopack+. 
 
Création de ‘package’ à imprimer 
Vous pouvez choisr de regrouper la même image à des formats différents dans un même pack, ou n’imprimer qu’un 
simple format. Ces différents formats de sorties peuvent être imprimés ensemble pour une même image. Il suffit de 
quelques clics. Vous pouvez choisissez d’imprimer plusieurs exemplaires d’une même image. 
 
Création de ‘template’ 
Choisissez un ‘template’ existant. L'image sélectionnée est placée dans celui-ci, et sors dans la taille demandée. Si le 
‘template’ contient un champ texte, vous pouvez  le renseigner, ou importer un fichier texte contenant les 
informations appropriées. NeoPack+ offre également la gestion des marques de coupe :  placez un repère de coupe 
dans votre ‘template’ et votre tireuse répercutera cette marque en sortie, en découpant si elle dispose d’un couteau, 
ou en pratiquant un trou (hole puch) qui sera ensuite détecté par le massicot automatique. 
 
� Nouveau dans la version 2.0  

Objets graphiques ‘étiquetés’  
Dans la version 2 de NeoPack+, les ‘templates’ peuvent contenir des objects graphiques ‘étiquetés’. Par exemple, 
vous pourriez avoir un certain nombre d'images qui partagent le même logo. Vous pouvez alors concevoir un 
‘template’ qui référence ce logo - par exemple le fanion d’un collège. Dans le programme principal, sélectionnez les 
images qui utiliseront ce logo, puis choisissez le fichier image. NeoPack+ associe automatiquement le logo avec les 
images selectionnés. 

 

 
 
 
 
 
Logo  
 
 
 
 

Masques transparents   
Chaque object graphique placé dans un ‘template’ peut être associé à un masque transparent de 8 bits. Ceci permet 
de créer des effets comme des fenêtres à bords progressifs. 
 
Champs textes  
Les ‘templates’ de NeoPack+ peuvent contenir des champs textes statiques ou dynamiques. En créant un ‘job’, le 
nom de fichier d’une image peut être directement écrit dans le champ correspondant. Le texte apparaît dans le ‘job’ 
comme dans le ‘template’ : avec la même taille, police et couleur. Le champ s’adapte automatiquement à la longueur 
du texte. 
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Importer du texte. 
NeoPack+ ne vous oblige pas à travailler avec du texte correspondant à chaque image. Néanmoins, vous pouvez 
importer des fichiers textes dont le contenu coincide avec vos images, évitant ainsi de devoir tout resaisir à la main. 
 
Print Queues (files d’attente) 
Tous les modèles choisis pour être imprimés sont visibles dans la fenêtre Queue. Ils peuvent être modifiés ou 
supprimés. 
 
Créer des files d’attente 
Des files d’attente peuvent être créées soit manuellement, soit en important des fichiers textes. 
Manuellement  
Pour créer une file d’attente manuellement, selectionnez un groupe d'images, puis un pack  (Layout/designs). Les  
packs sont ajoutés à la file d'attente. 
Données importées  
Si vous avez des informations de commande enregistrées dans un fichier texte, ces données peuvent être importées. 
Le pack sera alors appliqué aux image sélectionnées. 
 

Manipulation des images et des packs 
Les images doivent être importées dans NeoPack+ afin d’être intégrèes à la production. A l’importation, une vignette 
de prévision est créée puis enregistrée dans le fichier ‘.tnj’ de NeoPack+. A aucun moment les images d’origines ne 
sont modifiées.  
Cela signifie qu'il est possible d'envoyer les fichiers ‘.tnj’ sur des postes déportés hébergeant les images. Là, elles 
sont corrigées puis le job d’impression est effectivement crée. 
Chaque poste utilisant NeoPack+ ne peut partager l'information dynamiquement dans un environnement en réseau. Il 
est possible de stocker des images sur un serveur, mais celles-ci peuvent seulement être utilisées par un poste à la 
fois. 
De même, toutes les ‘queues’ sont disponibles seulement depuis le poste qui les a créées. 
 

Utilisation de l'interface de NeoPack+  
Une fois que NeoPack+ a été installé, sélectionnez le depuis démarrer > programmes > Timestone Software. 
NeoPack+ se lance. Si un message d’erreur vous demande un code de déverrouillage, ou annonce que le dispositif de 
protection n'est pas en place, consultez le chapitre 4 : installation  de NeoPack+. 
La fenêtre principale de NeoPack+ apparaît. Le programme vous montre ici un fichier avec une file d’impression 
ouverte. 
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fenêtre d’ajout de 
modèle/item 

fenêtre image 

 
 
 

 
 
 
 
 
fenêtre détail   fenêtre file d’attente 

 
# NeoPack+ impose une résolution d’au moins 800x600 en millions de couleurs. Si votre moniteur est 

configuré en 640x480, vous ne pourrez utiliser l'application correctement. La résolution peut être 
modifiée en utilisant le panneau de configuration affichage de Windows NT/2000. 

 
Utilisation de la barre d’outils. 
Chacune des barres d’outilss de NeoPack+ comporte un commentaire, et peut être déplacée à la souris. 
 
Commentaires  
Vous pouvez obtenir une courte description d'un bouton de la barre d’outils en plaçant le curseur de la 
souris au dessus pendant une seconde. Un ‘tooltip’ apparaîtra, donnant une courte description du 
bouton.  
 
Amarrage de la Barre d’outils  
Vous pouvez déplacer une barre d’outils et créer une palette flottante. Elle peut alors être placée n’importe où à 
l’écran. Pour cela, placez le pointeur de la souris près du bord de la barre d’outils, cliquez et déplacez là. 

 
 
Sélectez un outil ou un mode d'exécution. 
Vous pouvez accéder à différentes fonctionalités du programme en choisissant un bouton dans une palette. Un 
bouton enfoncé signifie que la fonctionalité est selectionnée. 
Dans l'exemple ci-dessous, plusieurs boutons sont ‘enfoncés ', indiquant qu’un mode est actif, ou qu’une fenêtre est 
actuellement ouvert. 
 



 

NeoPack + - Comprendre NeoPack+  Page 20
 

 
Cette fenêtre est ouverte  Le programme est en mode ‘Image preview’ 

 
Changer la taille des fenêtres  
Il est possible de changer la taille des panneaux de la fenêtre principale. Vous pouvez choisissez d’en placer un en 
plein écran ou au contraire de le fermer pour donner la priorité à une autre opération. 
Le passage de la souris au-dessus du bord d’un des panneaux changera la forme du curseur.  
Cliquez et déplacez la souris ; le bord du panneau se déplacera en fonction de votre souhait. 

 
Figure 1 : Changer la taille d’une fenêtre  
 

# Chacun des ‘panneaux’ a une taille minimum. Si vous la dépassez, il disparaîtra complètement et les 
autres se redimentionneront pour combler l’espace libre. 

 

Afficher, masquer et ‘maximiser’ les panneaux 
Les panneaux  peuvent être ouverts complètement pour prendre tout l'espace disponible, ou bien être fermés 
complètement. 
 
Afficher et masquer les panneaux 
Les panneaux  peuvent être affichés ou masqués en les selectionnant dans le menu View. Si le nom 
du panneau est coché dans le menu, il sera visible dans l’application. Sélectionnez le, et la ‘coche’ 
disparaîtra. Le panneau sera alors masqué. 
Redimentionner un panneau à la souris peut également servir à le masquer ou à l’afficher : dépassé 
une taille minimale, il se fermera. Il est possible de rendre visible un panneau préalablement 
masqué en déplaçant une de ses bordures à la souris. 
 

Raccourcis claviers 
Il y a beaucoup de raccourcis qui permettent de se passer de la souris. Ces raccourcis sont indiqués 
dans les menu ou dans les palettes d’outils. 
Par exemple, si vous souhaitez ajuster le contraste d'une image, appuyez et maintenez les touches Ctrl + C. Le 
curseur se déplace automatiquement  dans la palette de réglage du contraste. 

 
Raccourci indiqué dans  
la palette d’outils  

Raccourci de palette indiqué  
dans le menu  
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6 
Configuration de NeoPack+  

 
Réglages par défaut de l’application 
Il y a un certain nombre réglages qui doivent être remplis pour personnaliser NeoPack+.   

Unités de mesure  
Vous pouvez choisissez votre unités de la mesure en selectionnant File > Options > Général. 
La boite de dialogue suivante apparaît. 

 
Figure 2 : Le menu Options  
 
Sélectionnez votre unité de mesure, puis cliquez sur OK. 
 
Selectionnez la taille des vues  
Lorsque vous visualisez un pack dans l’application, sa taille d’affichage dépend de ce que vous allez rentrer ici. Par 
exemple, si votre pack fait 20 x 20 cm, et la ‘view size’ est placée à une largeur et une hauteur de 450 cm, le pack 
apparaîtra tout petit. Réciproquement, si votre pack fait 20 x 40 cm et la ‘view size’ est placé à 25 x 25 cm, le pack 
sera coupé dans la fenêtre. 

 
Figure 3 : Le même modèle avec la  ‘view size’ placé à 20x20 (à gauche), et à 12x12 (à droite)  
 

Éditeur D'image  
NeoPack+ permet l'édition des images par l'intermédiaire d'une application externe telle qu’Adobe Photoshop. Il 
suffit d’indiquer l’emplacement du ‘.exe’ de l'éditeur dans le champ image editing application, ou de cliquez sur le 
bouton parcourir (…). Une boite de dialogue s’ouvre, localisez l’application. L'éditeur d'image est configuré. 
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Si l'éditeur d'image que vous avez choisi supporte le format ‘.psd’ d'adobe Photoshop, choisissez le comme format 
d’échange. Sinon, choisissez le format de fichier ‘.bmp’. 
 

# Si vous utilisez le BMP comme format d’échange, faites attention de bien sauvegarder vos 
images dans ce même format une fois modifiées ! NeoPack+ ne rechargera le fichier édité que s'il a le 
même nom et la même extension. Si vous avez créé des calques, prenez soin d’aplatir l'image afin de 
pouvoir enregistrer votre fichier en BMP. 

# L'éditeur externe n’est disponible que pour les images qui ont été ‘entièrement’ importées. Si vous 
importez des images juste avec la vignette, l'échange n'est pas disponible (menu Import Images > Setup). 

 

Rapports d’homothétie  
Les rapports hauteur/largeur permettent de voir le positionnement de l’image par rapport à la taille du papier. Il 
existe plusieurs tailles standards utilisées dans le monde photographique, mais vous pouvez en créer pour vos propres 
besoins. 

Déterminer la découpe idéale  
Lorsque vous créez un pack, il est possible d’y intégrer différents formats ayant des rapports d’homothétie différents. 
Il est important que l'image s’inserre correctement dans le format choisi. 
Une fois qu'un rapport d’homothetie a été défini, il peut être mis en incrustation sur une image. Il est possible d’en 
faire apparaître plusieurs en même temps, ainsi vous pouvez voir comment une image apparaîtra dans chacun des 
formats. Dans l'exemple ci-dessous, trois repères ont été créés : 

• 5:7 - applicable à 5 x à 7", et tous ses multiples, 

• 4:5 - applicable à 4 x à 5", et tous ses multiples, 

• 1:1 - applicable à 3 x à 3", et tous ses multiples. 

 

 
Repère 5 :7 
 
Repère 4 :5 
 
Repère 1 :1 
 
 
 
 
 
 
 
 

Figure 4 : Image montrant 3 rapports hauteur/largeur différents  
 
Comme indiqué plus haut, vous pouvez modifier une image en changeant sa taille (zoom), ou en la déplaçant à la 
souris. L’utilisation de ces commandes vous permet de placer  votre de façon optimale pour tous les rapports 
d’homothétie de papier.  
 
Ces repères ne sont utilisés que lorsque l’image ne correspond pas au format : les tailles d'impression sont en général 
définies en fonction des largeurs de papier et non des tailles des images. 

Définir les repères d’homothétie (aspect ratio)  
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Les repères peuvent être renseignés par défaut, ou être associés à une série d’images. Les nouveaux fichiers 
afficheront les repères par défaut. Chaque repère que vous ajoutez via le menu Edit > aspect ratio n’est disponible 
que pour le fichier courant. 
 
Repères par défaut  
Depuis le menu File, choisissez Options. Une boite de dialogue s’ouvre. Choisissez l’onglet Default. 

 
Figure 5 : L’onglet Default des options  
 
Choisissez Aspect ratios > Edit. L'éditeur de repères s’ouvre. Toutes les informations ajoutées ici seront disponibles 
pour chaque nouveau fichier créé depuis Neopack+. 
 
Définir les repères d’homothétie (aspect ratio)  
Choisissez Edit > Aspect Ratios… la boite de dialogue s’ouvre. 

 

 
Repère affiché 
Oui/Non 
Couleur du repère 

Hauteur 

Largeur 

Nom du repère 
 

Figure 6 : La boite de dialogue des rapports hauteur/largeur  
 
Vous noterez que la première fois que vous ouvrez  cette boite de dialogue, il peut déjà y avoir des informations.  
 
Créer un nouveau repère  

• Choisissez New dans la boite de dialogue. Une nouvelle ligne s’ajoute à la liste  

• Cliquez à l'intérieur de la zone Description, et entrez le format de votre repère. 

• Cliquez à l'intérieur de la zone Width et entrez une largeur, puis Height pour la 

hauteur. 

• Cliquez sur l’icône de couleur. Une palette de couleur apparaît. Choisissez une couleur.  

• Cliquez sur la case à cocher On pour rendre visible votre repère.  

 
Importer des repères existants  
Vous pouvez importer des repères préalablement créés dans un fichier NeoPack+. Selectionnez Import from file 
depuis l’onglet Default de la boite de dialogue Options. Choisissez le fichier ‘.tnj’ qui contient les repères et cliquez 
sur Open. Vos repères sont importés dans la liste. 
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Changer l’ordre de la liste  
L’ordre d’affichage des repères peut être modifié en utilisant les flèches.  
 
Afficher un repère d’homothétie 
Une fois que les repères ont été créés par défaut, tous les fichiers y auront accès. Pour les afficher, selectionnez le 
mode ‘Crop Images’ (découper les images) en selectionnant Images > Select crop & scale Image tool, ou en 
cliquant sur le bouton ‘Crop Images Tool’  (outil de découpe des images) dans la barre d’outils.  
Les repères s’affichent au-dessus de l’image. 

 
Figure 7 : Image montrant des rapports hauteur/largeur  
 
Utilisation des repères d’homothéties  
Ces repères indiquent la façon dont l’image originale va être ‘coupée’ à l’impression. Pour plus d’informations sur 
les outils de zoom et de recadrages, consultez le chapitre 7. 
 

Définir des champs par défaut  
NeoPack+ dispose d’un outil puissant qui permet de positionner du texte sur chaque image. Celui-ci est placé 
automatiquement dans le pack comme il a été placé dans le ‘template’. Le texte est ajouté au ‘template’ en ajoutant le 
caractère ‘@’ suivi d’un code prédéfini.  
Vous pouvez créer vos propres codes qui seront ensuite ajoutés à vos packs. Par exemple, vous pouvez vouloir 
ajouter le nom de chaque élève sous une serie de photos d’identités 
Vous avez la possibilité de créer autant de champs que vous le désirez, même une fois que votre fichier ‘.tnj’ a été 
créé. 

 

 

Ajouter des champs par défaut  
Choisissez File > Options puis l’onglet Défaut. 
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Cliquez  sur le bouton Details Fields > Edit. La boite de dialogue de création de champs par défaut s’affiche. 

 

 

Ajouter un nouveau champ  
Cliquez sur  Add. Une nouvelle ligne apparaît. Positionnez le curseur dans le champ de saisie Name, et taper le nom 
du champ. Les noms de champ ne sont pas sensibles à la casse :  ‘Name’ est identique à ‘name’. 
 
Choisissez le type de champ  
Après avoir ajouté le champ, cliquez sur Type. Choisissez le type qui vous convient dans la liste. 
Les champs peuvent être du type : 

• Texte : Texte normal, 

• Numéro: Un nombre  entier,  

• Date : Une date. 

 
� Nouveau dans la version 2.0  

La Version 2.0 introduit un nouveau champ dit graphic. Une zone graphique signifie que le champ doit être une 
image. 

 

Définir l'emplacement des fichiers images  
NeoPack+ importe les images de deux façons différentes. Les images peuvent être importée entièrement, c’est à dire 
que l'image originale n’est plus exigée par NeoPack+. A l’inverse, l’application peut ne conServeur que le lien vers 
les images. En les important de cette façon, l’application créée une vignette en basse résolution pour que l’utilisateur 
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puisse voir les modifications appliquées aux images. Le fichier original n’estt nécessaires que lors du lancement de 
l’impression.  
Neopack+ utilise plusieurs moyens pour localiser les images d’origines. Il peut enregistrer l'emplacement initial des 
fichiers au moment de l’importation, ou vous qui lui indiquez le chemin pour les retrouver. 
 
ConServeur l'emplacement initial 
Si vous utilisez l’option  Remember the actual path au moment de l’importation des images, vous n’avez pas 
besoin de renseigner de chemin de recherche par défaut. Consultez le chapitre 6 pour plus de détails. 
 
Créer un répertoire d'image  
Dans les grands laboratoires, il est necessaire de définir un répertoire racine pour héberger toutes les images. Il y a 
plusieurs moyens de renseigner ce chemin dans NeoPack+ : 

• Le répertoire racine 

• Le même répertoire que le fichier ‘job’  

• Un sous-répertoire à partir du fichier ‘job’  

 
Répertoire racine  
L'utilisation d’un Image root directory (repertoire racine des images) permet de stocker toutes les images d’un 
‘job’dans un seul dossier. Par exemple, vous pourriez choisissez d’appeler la machine hébergeant les images  
ImageServeur. Celle-ci possèderait un lecteur partagé Data, et toutes les images seraient hébergées dans des 
dossiers appartenant au répertoire \Images. 
Les conventions de nommage permettent d’acceder à ce repertoire de la façon suivante : 
\\ImageServeur\Data\Images, en supposant que le dossier Images soit partagé sur le réseau. 
Enfin, vous devrez toujours indiquer le répertoire final de recherche pour trouver les images d’origine. Utilisez le 
code ‘@+’, NeoPack+ ajoute alors le nom du fichier ‘.tnj’ à la fin du chemin de recherche.  
Dans le cas ci-dessus, chaque fichier ‘.tnj’ serait nommé Job1, Job2 et Job3. Ainsi, si le chemin est 

\\ImageServeur\Data\Images\@+  
Et que le fichier ouvert s'appelle Job2, NeoPack+ recherchera les images dans  

\\ImageServeur\Data\Images\Job2 \  
¶ 
Le même répertoire que le fichier ‘job’  
Si le chemin indiqué est 
.\ 
NeoPack+ recherchera les images dans le même répertoire que le fichier ‘.tnj’. 
 
Un sous-répertoire à partir du fichier ‘job’  
Les images peuvent être enregistrées dans un sous-répertoire. Par exemple, si le fichier ‘job’ se trouve dans le dossier 
\Images\Job1, et les images correspondantes dans \Images\Job1\Source, il suffit d’indiquer à NeoPack+ le chemin de 
recherche suivant 
\Source  
NeoPack+ recherchera les images dans le sous-répertoire \Source. 
 
Définir l'emplacement des modèles (templates) 
Les ‘templates’ peuvent être stockés n’importe où. Mais leur emplacement doit être défini avant de créer un nouveau 
job. 
 
Ajouter un chemin de recherche 
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Choisissez File > Options puis Path > Design Files. Maintenant, cliquez sur New. Une nouvelle ligne apparaît dans 
la boite de dialogue. Indiquez le chemin complet de stockage des ‘templates’. Vous pouvez choisissez un chemin 
réseau (\\ComputerName\ShareName \…) ou la lettre correspondant à un disque réseau. 
Vous devez redemarrer l’application pour que les changements prennent effet. 
 

Définir les groupes de modèles (packs set)  
Vos packs une fois crées, peuvent être regroupés. Vous pourriez vouloir regrouper tous 
ceux qui utilisent une cassette de 8" d’une part et de 10" d’autre part. En utilisant 
l’application, vous pouvez choisissez d’accéder à un groupe particulier. 
Chaque pack peut contenir n’importe quelle combinaison de tailles de photos et peut être 
sauvegardé sous un nom de votre choix. Vous pouvez aussi leur assigner un raccourcis 
clavier qui vous permet de les selectionner très rapidement. 
Si les packs ne sont pas regroupés, ils apparaîtront tous ensemble dans l’application. 

Définir les groupes de modèles par défaut  
Ouvrez l'éditeur de pack Edit > Packs… l'éditeur de packs s'ouvre. 
 
Étape 1 :Créer et nommer le groupe de modèles  
Choisissez New depuis Set List. Une nouvelle ligne apparaît dans le tableau Set List. Entrez un nom définissant ce 
groupe. 

 
 
Étape 2 : Ajouter les packs  
Choisissez Add depuis la boite de dialogue Packs in set. Une nouvelle ligne apparaît dans le 
tableau Packs in set. Notez que le choix du pack se fait par une liste déroulante. 
Cliquez sur la flèche de la ‘combo box’. La liste des packs disponibles s’affiche. 
Selectionnez le modèle que vous souhaitez ajouter. 
Cliquez dans le champ Description et donnez un nom au pack. Ce nom sera utilisé par 
l’application pour identifier le modèle. Ajoutez une touche de raccourci. 
Cliquez dans le champ Key et taper une lettre. Une simple pression de ce raccourci dans 
l’application vous permettra d’associer une ou plusieurs images à ce modèle. Vous pouvez 
d’ailleurs indiquer une serie de lettre. Par exemple, LY1 pour le pack 1 du lycée. 

 
# Un raccourci écrit ici écrase celui que vous avez défini dans les propriétés d’un pack à sa création 

(Template designer Mode > Properties). 

 
Une fois que tous les packs que vous vouliez ajouter au groupe sont présents, clickez sur OK et la boite de dialogue 
se fermara. 
 

# Utilisez des noms comprehensibles pour vos opérateurs et n’ajoutez pas deux fois le même nom. 

# Tous  les raccourcis créés ici écraseront ceux défini dans les propriétés d’un pack à sa création. Consultez 
le chapitre 6 ‘Céer des Templates’ pour plus de détails. 
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Etalonnage de l’écran 
Si vous le désirez, un assistant de calibration d’écran est fourni avec NeoPack+. Pour l’utiliser, allez dans File > 
Options > LUTs et cochez la case enable montior LUT. Puis lancez l’assistant en cliquant sur  Calibrate. Consultez 
le chapitre 10, ‘Etalonnage’ pour plus d'information concernant la calibration de l’écran. 
 



 

NeoPack + - Créer des ‘templates’  Page 29
 

  

7 
Créer des ‘templates’  

 
NeoPack+ utilise des ‘templates’ dans tous ses jobs. Il en existe deux types : 

• Le ‘Layout’ d’un pack (layout) - définit les tailles et leur positionnement,  

• Un objet du pack (item) - définit une composition graphique qui est associée au layout. 

Un ‘job’ dans NeoPack+ se compose d'une image choisie et placée dans un layout. Celui-ci précise la taille des 
photos dans le pack final. Un item est optionnel. Il définit en quelque sorte une création graphique associée aux 
images et sera ajouté dans le Layout avec les photos ; un cadre est un item. 
 

Comprendre les notions de Layout et de Item 
Il est important de comprendre la différence entre un Template, un Layout et un Item. 
 
Le template  
Un ‘template’ peut être composé d’un ou plusieurs Layouts associé à un ou plusieurs Item. En règle générale, un  
‘template’ est n'importe quel fichier créé par le ‘Template designer’. 
 
Le Layout  
Un Layout décrit le positionnement et la taille des images qui forment l’impression finale. Les Layouts 
peuvent contenir un seul format (18x24 par exemple), ou être associés à une image de fond (background 
image), à des objets graphiques, des textes ou des codes barres. 
Pour utiliser un Layout, sélecter une image, puis choisissez le Layout. Vous verrez l'image apparaître dans 
la fenêtre en bas à droite. 
 
Item  
Les items sont des groupes d’objets graphiques ou de textes qui peuvent être superposés au-dessus des 
images, comme des cadres par exemple. Chaque partie vide détermine l’endroit où l'image apparaîtra dans 
votre création graphique (design). 
Pour ce faire, sélectionnez d'abord le Layout, puis l’item que vous souhaitez lui appliquer. L'image 
s’intègre dans la création graphique, et s’adapte au positionnement défini par le Layout. 
Chaque item se met donc automatiquement à la taille de l’image. Pour cette raison, il est impossible 
d’utiliser des codes barres, qui eux sont caractérisés par leurs tailles.  
 
 
� Nouveau dans la version 2.0  

La version 2 de NeoPack+ introduit la possibilité d’importer un cadre (masque) dans un ‘template’, il se comporte 
comme un item. En outre, vous pouvez choisissez d’imprimer des images en noir et blanc ou en sepia. Cela vous 
permet de créer des packs ludiques et attrayants en quelques clicks. 
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Utilisation du ‘template designer’ (créateur de template)  
Le template designer est intégré dans NeoPack+. Pour l'utiliser, lancez l’application, puis choisissez Mode > 
Template designer. Le template designer s’ouvre. 
Noter que la plupart des options sont grisées et donc indisponibles. 
 

Créer un nouveau ‘template’  
Passez en mode Design en sélectionnant Mode > Template designer ou appuyant sur la 
touche F8. Choisissez File > New. La boite de dialogue New Template design s'ouvre. 
Maintenant, clicquez sur  Pack Layout pour créer un nouveau Layout. 
 

Le template designer  
Le ‘designer’ est divisé en plusieurs parties : 

• La barre d’outils principale, 

• La barre d’outils de dimentions et d’unité de mesure,  

• La zone de travail. 

En fonction de votre mode de travail, certains des boutons de la barre d’outils peuvent ne pas être disponibles. 
 
 
 
 
La zone de travail  

La barre d’outils des dimensions et des unités 

La barre d’outils principale 
 
 
 
 
 

Les barres d’outils  
Il y a plusieurs barres d’outils qui vous permettent de choisissez diverses options à la creation de votre ‘templates’. 
 
La barre d’outils fichier  
Cette barre d’outils vous donne l'accès rapide aux raccourcis du menu File. 
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Enregistrer le Template ouvert 
Ouvrir un Template 
Créer un nouveau Template 

 
La barre d’outils de placement 
Cette barre d’outils vous permet de placer des éléments dans le ‘template’. Il y a 6 éléments de base : 
  
� Nouveau dans la version 2.0 - objet graphique indexé (tagged graphic)  

Image (Image object) Définit l’endroit où les images importées dans l’application apparaîtront dans le ‘template’. 

Objets graphiques 
(Graphic Object) 

Définit l’endroit où des objets graphiques apparaîtront dans le ‘template’. Contrairement aux 
‘Images Objects’, ceux sont des éléments statiques. Il peut s’agir de bitmaps, de WMF ou 
d'EMF.  

Textes (Text Object)  
Définit l’endroit où les textes apparaîtront dans le ‘template’. Le texte peut être statique, ou 
contenir un code spécial précédé du ‘@’. Les textes se mettent automatiquement à la taille de 
leur enveloppe. 

Code Barre (Borecode 
Object) 

Définit l’endroit où les codes barres apparaîtront dans le ‘template’. Comme expliqué plus 
haut, il est impossible d’integrer un code barre dans un Item (un cadre ou un fond). 

Objet graphique 
indexé (Tagged 
graphic object) 

Place une zone qui sera remplacée par un élément graphique pour chaque image. 

 
Tous ces éléments, à l’exception des codes barres, peuvent être utilisés soit dans un Layout, soit dans un ’template’. 
Pour placer un de ces éléments, cliquez le bouton désiré, puis cliquez à l'intérieur de l’espace de travail et créez une 
zone à la souris. L'élément sera placé dans le ‘template’ prêt à être modifié ou déplacé. 
 
 
 
 
 
 

 
 

Placer un objectif de trou d'image      Placer un object graphique étiqueté  

Placer un object graphique        Placer un code barre  

Placer un objectif des textes  
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La barre d’outils des calques 
Chaque élément d’un ‘template’ est positionné par défaut sur un nouveau calque. Cela vous permet de changer 
l’ordre des calques et de faire passer chaque élément devant ou derrière un autre. 
Pour changer l’ordre des calques, sélectionnez votre objet puis changez sa position en utilisant un des boutons de la 
barre d’outils. 
 

 
 

Envoyer en arrière plan 

Envoyer au premier plan 
Passer sur le calque du dessous 
Passer sur le calque du dessus 
 

Les barres d’outils de mise à l’échelle et d’options  
Vous pouvez choisissez comment l’image va venir se placer dans votre zone image si elles ne sont pas 
homothétiques. Cela permet de savoir si une photo s’affichera plein cadre ou si ses proportions seront modifiées. 
Il y a trois options disponibles : 

• Couper l'image pour remplir la zone en maintenant ses proportions, 

• Afficher l’image plein cadre dans la zone en maintenant ses proportions (des marges blanches apparaîtront), 

• Remplir la zone avec l’image en déformant celle-ci. 

 

Changer les options de mise à l’echelle 
Une fois que l’objet graphique est placé sur la zone de travail, selectionnez l’option choisie dans la barre d’outils 
Scaling Options. 
 

Choix Resultat … 

Couper l'image pour remplir la zone en maintenant ses proportions 

 
 

Afficher l’image plein cadre dans la zone en maintenant ses proportions (des marges 
blanches apparaîtront) 

  

Remplir la zone avec l’image en déformant celle-ci 

 
 

 
 
Application d'un masque de 8 bits  
Les masques sont des fichiers image (JPEG, tiff, bmp etc..) qui vous permettent d’introduire le principe de 
transparence dans vos impressions. Vous pouvez appliquer ces masques sur tous les objets graphiques presents dans 
vos templates. 
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Configurations de la grille  
Certains outils peuvent vous faciliter la création des templates. Ils sont disponibles depuis la barre d’outils Display / 
Snap. Ces outils permettent : 

• D’afficher ou de masquer les règles,  

• D’afficher ou de masquer les repères de coupe, 

• D’afficher ou de masquer la grille, 

• De coller les objets sur la grille.  

 
 
 

Afficher / Masquer les règles      Coller à la grille 

Afficher les repères de coupe      Afficher la grille 

 
Règles 
Cliquez sur le bouton Switch ruler display pour afficher ou cacher la grille. 
 
 

     Règles 
 
 
 
 
Affichage des repères de coupe (punch hole)  
Les ‘templates’ peuvent contenir des repères de coupe. Cliquez sur le bouton Display hole punch pour afficher ces 
repères. 
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Repère de coupe 
 
 
 
 
 
 
 
 
 

 
 
Affichage de la grille  
Une grille peut être placée sur le ‘template’ facilitant ainsi le placement des objets. Cliquez sur le bouton  Display 
grid pour afficher la grille. 
 

 
 
 

Grille 
 
 
 
 
 
 

 
 
 
‘Aimanter’ la grille (snap to grid) 
Avec cette option, les objets s’aligneront automatiquement sur la grille. 
 
Réglage des options du ‘Designer’  
L'affichage de la grille peut être configuré en choisissant File > Designer options en mode Designer. 
L'échelle de la grille peut être configurée differemment pour les Layouts et le Templates. L’option  Automatic 
spacing sélectionne une configuration automatiquement. Si vous désirez une configuration particulière, décochez 
cette option et entrez vos valeurs.  
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La barre d’outils orientation 
Lorsque vous ajouter un cadre à la liste de vos ‘items’, vous pouvez lui permettre de se positinner automatiquement 
en portrait ou en paysage. Vous pouvez aussi, dans un même template, définir manuellement un cadre pour chaque 
orientation. 
Lorsque vous créez vos deux orientations, vous devez avoir des cadres dessinés pour le format portrait et paysage. 
Dans l’exemple ci-dessous, une photo en format paysage a été placée derrière un cadre en format portrait. 
Remarquez qu’il est impossible de recouper la photo correctement. 

 
 
Dans les deux cas, NeoPack+ choisisseza l’orientation qui convient à l’orientation de votre image. Des informations 
plus détaillées sont fournies plus loin dans ce chapitre. 
 

 
 
 
 
Passer à la version paysage 

Créer une version dans les deux orientations 
 
 
La barre d’outils des dimensions 
Vous pouvez placer avec précision chaque objet dans un ‘template’ grace à la barre d’outils Dimensions. 
Sélectionnez un objet, puis renseignez sa taille exacte et sa position. Terminez en clicquant sur le bouton Apply pour 
appliquer les valeurs. 
La position d’un objet est définie à partir de son coin superieur gauche. 

 
unités de mesure  position taille 
 

Créer Des ‘templates’  
Avant de construire un ‘template’, il faut s’assurer de disposer des éléments nécessaires (tailles des images, 
positions, etc …). Le ‘template designer’ ne dispose d’aucune fonctionalité de retouche d’image, mais NeoPack+ 
permet de créer un lien vers une autre application graphique (CorelDraw, Adobe Photoshop, ect …). 
 
Créer un template ‘Pack Layout’  
Il s’agit en fait d’une surface de papier sur laquelle vont venir se positionner plusieurs exemplaires d’une même 
image pour former un ‘package’. Passez en mode Designer (F8) en choisissant Mode > Template designer. Puis 
File > New, pour ouvrir un nouveau document. Dans la selection, choisissez Pack Layout. Un ‘template’ vierge 
apparaît. 
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Definissez la taille de la page  
La première étape consiste à définir votre surface de papier en indiquant sa longueur et sa largeur. Si vous ne voulez 
imprimer qu’une image dans un seul format, la surface de papier correspond à celle de l’image. Si vous choisissez de 
créer un package, la surface de papier correspond à la surface totale de tous les formats qu’il contient. 
Renseignez la surface de votre ‘template’ après avoir selectionné le fond. Tant que vous n’avez pas cliqué sur le 
fond, la barre d’outil Dimensions reste indisponible. Vérifiez que l’unité affichée dans le menu déroulant de gauche 
est la bonne.  Remplissez les champs et appuyez sur Apply. La taille de la page change. 

 
Figure 8 : Page sélectionnée avec les ‘poignées’ apparentes  
 
 
Placement des objets  
Vous placerez tous vos objets graphiques de la même façon : 

• Choisissez le type d’objet à placer dans la barre d’outils,  

• Dessinez une zone à la souris sur la page,  

• Choisissez les options de l’objet,  

• Renseignez sa taille. 

 

Utilisation de la grille 
Le template designer despose de plusieurs options utiles pour placer des objets dans un ‘template’ : 

• Des règles,  

• Une Grille,  

• Aimanter la grille.  

Les règles et la grille sont des élémnets d’aide visuelle au placement. Aimanter la grille permet d’aligner 
automatiquements tous les objets dans la page.  
 
Créer un Layout contenant une image unique 
Les images que vous importez viennent se placer dans les ‘trous’ que vous avez préalablement placés dans un 
‘template’. Vous pouvez placer autant de ‘trous’ que vous désirez dans un ‘template’ ; chacun peut avoir une taille 
ou une orientation différente. NeoPack+ ajuste automatiquement chaque image aux dimensions des ‘trous’. 
 
Pour créer un ‘trou’, cliquez sur le bouton Place Image Hole         . Le curseur change d’apparence. 
Placez la souris au-dessus de la page où vous voulez que le trou apparaisse. Puis déplacez votre souris. Il n'est pas 
important d'être précis à ce niveau. La boite de dialogue  Image Properties apparaît. 
 
� Nouveau dans la version 2.0   
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Il y a un certain nombre d'options disponibles : 

• Item design - si vous selectionnez un cadre dans la fenêtre ‘items’, elle sera placée à cet endroit,  

• Image - une image simple sera placée à cet endroit sans tenir compte de la présence d’un ‘items’,  

• As black and white - crée une image en noir et blanc, 

• As sepia/colorized – applique un virage à l’image. 

 

 Le terme item est expliqué plus loin dans ce manuel. Si vous choisissez Item design ici, une frame sera 
rajouté au-dessus de l’image. Si vous choisissez Image, l’image sera simplement ajouté au modèle. 

 
Choisissez un type d'image, puis appuyer sur OK. 

 
Trou placé avec l’option Image (without 
item design) 
 
Trou placé avec l’option  
Item design 

Trou placé avec l’option  
Image as black & white 

Trou placé avec l’option  
Image as sepia/colorized 
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Figure 9 : Un objet image placé dans un Layout  
 
Position et taille d’un objet  
Chaque objet peut être positionné grossièrement en utilisant la souris, ou plus précisément en renseignant sa taille 
dans la barre d’outils Dimensions. Selectionnez l'objet. Notez qu’il devient actif, et que des poignées apparaissent à 
ses coins. 

 
Figure 10 :Un objet sélectionné 
  
Travailler avec la souris  
Pour fixer la taille d’un objet à la souris, il suffit de selectionner une poignée et de la déplacer à l’endroit voulu. 
 
Travailler avec le barre d’outils  
La taille et la position exacte d’un objet peut être renseigné en utilisant la barre d’outils Object Dimensions. 
Sélectionnez votre objet puis entrez les valeurs que vous souhaitez modifier. Utilisez la touche Tab pour passer d’un 
champ de saisie à l’autre. Validez les changements en appuyant sur Apply. 
Vous pouvez changer d’unité de mesure en cliquant dans la boite de dialogue Units. 

 
Figure 11 :  la barre d’outils Object Dimensions 

 
Figure 12 : Un objet image après l’avoir redimensionné 
 
Pour créer un layout contenant une seule image de 5’’ par 7’’ (13x18) en format portrait, mettez les valeurs Offset X 
et Y à 0, puis Size à 5’’ (127mm) et 7’’ (178mm).  
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Créer un Layout contenant plusieurs formats  
En plaçant plus d’une image sur la zone de travail, vous créez un package print template ou modèle d’impression. 
Appliqué à une image dans NeoPack+, il se charge automatiquement de son placement pour construire l’impression 
finale. 
Pour créer un Layout, définissez une taille de papier assez grande pour y loger tous vos formats, puis positionnez le 
premier comme au paragraphe précédent. Recommencez cette opération jusqu’à ce que votre layout soit complet.  
 
Exemple  
Nous allons créer un modèle simple, contenant un 10 x 8" (20x25) et deux 5 x 7" (13x18). 

 

 

Étape 1 : Définir la surface de papier.  
Créez un nouveau Layout. Cliquez le fond de page. Notez que les champs de saisie Size deviennent disponibles, 
mais pas les champs Offset. Placez la taille de page à 15’’ (38 cm) par 10’’ (25,4 cm) pour que tous nos formats 
puissent tenir. 
 
Étape 2 : Placer le format 10x8"  
Choisissez le bouton Image Hole, puis définissez une zone à la souris. Il est inutile de travailler avec trop de 
précision pour le moment. 
 
Étape 3 : Taille et placement du format 
Sélectionez le format. Des poignées noires apparaissent autour de l’objet pour signifier qu’il est actif, les champs de 
saisis Dimensions deviennent accessibles. 
Chaque objet est positionné par rapport à son coin superieur gauche. Comme nous voulons placer notre format 
8x10’’ en haut à gauche de l’espace de travail, il faut entrer les valeurs 0,0 dans les champs Offset. Entrez enfin la 
taille du format, soit 8x10’’ dand les champs Size. 

 

Étape 4 : Placer le premier format 5x7"  
Choisissez le bouton Image Hole à nouveau et reproduire l’étape 2. Sélectionez le format avec la souris. 
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Étape 5 : Taille et placement du format  
Cette fois, il faut placer ce format à la suite du précédent. Le coin superieur gauche doit donc se trouver aux 
coordonnées 8,0. Entrez ces valeurs dans les champs Offset puis remplir les champs Size avec 5 et 7. Validez en 
appuyant sur Apply. Le second format est placé comme suit : 

 

 

Étape 5 : Placer le deuxième format 5x7"  
Sélectionnez le dernier format, copiez le par Edit > Copy (Ctrl + C) puis cliquez sur la zone de travail et collez un 
nouveau format par Edit > Paste. 
 
Étape 6 : Taille et placement du format  
Il ne reste qu’à placer ce dernier format sous le précédent, c'est-à-dire aux valeurs Offset 8,5 et de valider par Apply.  

 

 

Sauvegarder le ‘template’  
Une fois que votre Layout est construit, vous devez l’enregistrer pour pouvoir l'utiliser dans NeoPack+. Vous 
disposez de plusieurs moyens pour les identifier.  
 
Entrer les Template Properties 
Vous pouvez créer à la fois un nom et une touche de raccourci pour chaque ‘template’. Le nom que vous indiquez est 
le nom qui sera affiché dans l’application.Un raccourci correspond à une touche associée au templet qui le 
sélectionne de façon unique et automatique.Par exemple, si vous associez la touche ‘A’ au Layout créée 
précédemment, à chaque fois que vous appuirez sur ‘A’ le programme appliquera ce Layout à l'image sélectionnée. 
Pour fixer ces options, choisissez File > Properties. Les propriétés du ‘template’ sont afichées. 
Écrivez le nom que vous souhaites afficher, et le raccourci. 
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Si vous ne placez pas les propriétés du ‘template’, le nom affiché pour désigner ce template est le nom de fichier 
sous lequel vous l’avez enregistré sur votre disque dur. 
  
Enregistrer le ‘template’  
Une fois que les propriétés ont été entrées, vous pouvez sauvegarder le ‘template’ sur le disque dur. Il doit être 
sauvegardé dans le répertoire défini plus tôt dans les Options Template file path. Consultez Le Chapitre 5,  pour plus 
de détails. 
Choisissez File > Save. Une boite de dialogue s’ouivre. Naviguez jusqu’au bon répertoire, donnez-lui un nom, puis 
choisissez save. Le ‘template’ est sauvegardé. 
 

# Vous devez quitter et le relancer NeoPack+ avant de pouvoir utiliser le nouveau ‘template’. En effet 
l’application ne charge les modèles qu’au démarrage. 

 
Utiliser le nouveau ‘template’  
Après avoir sauvegardé le ‘template’ et relancé le programme, ouvrez un job. Vous verrez que le nouveau Layout est 
maintenant disponible.Cliquez sur une image, puis sur le bouton du Layout. L'image est placée dans le modèle. 
 

Inserrer du texte dans vos Templates 
NeoPack+ vous permet d’inserrer des images fixes (tel qu'un logo ou une image de fond), du texte - qui  peut être 
fixe ou dynamique, et des codes barres dans un layout.   
Vous devez d’abord créer votre Layout avant de pouvoir ajouter vos champs textes.  
 

# Vous apprendrez à placez et utiliser des objets graphiques et de textes plus loin dans ce chapitre.  

 
Utilisation d'un objet Code Barre 
Vous ne pouvez inserrer un code barre que dans un Layout.  En effet un code barre 
possède une taille et une résolution spécifique et seul un layout permet de rendre ces 
caractéristiques.  
Pour placez un code barre dans votre Layout, cliquez sur sur le bouton Barcode Objet 
dans la barre d’outils.  Définissez une champ à la souris à l’endroit où vous voulez placer 
le code barre.  La boite de dialogue Edit Barcode apparaît.  
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Indiquez le type de code barre en choisissant dans la liste Barcode type.  Les types disponibles sont : 

• Code 39  

• Code Étendu 39  

• Code 128  

Maintenant, entrez le texte à coder. Vous pouvez spécifier un texte fixe, ou utiliser la variable ‘@’ qui caractérise un 
texte dynamique.  Par exemple, vous pouvez avoir créé un champ ID dans la fenètre détail  pour identifier chaque 
image.  Si vous entrez la chaine ‘@ID’ dans le champ Text to encode, le contenu du champ ID sera transformé en 
code barre.  Finissez par renseigner la taille de votre police dans le champ Characters/inch.   
Vous pouvez choisissez la couleur utilisée par le code barre ; ce qui est particulièrement utile si vous utilisez un 
imageur CRT.  En effet ces imprimantes tendent à baver lorsqu’on utilise un noir ‘plein’, rendant les code barres très 
difficile à lire.  Choisissez la couleur en cliquant sur le menu déroulant  Bar color ou appuyez sur More colors.  La 
palette de choix des couleurs standard de Windows s’ouvre alors.  Faites votre choix et testez l’impression si 
nécessaire pour déterminer la configuration optimale.  

 

 
 
 
 
Fixez la luminosité à une valeur superieure à zéro pour 
éviter d’avoir des problèmes avec un CRT. 
 
 
 

 
Une fois les réglages effectués, choisissez  OK.  Votre code barre est positionné sur le Layout.  
 

# Vous devez déterminer quelles configurations fonctionnent avec votre lecteur de code barre en réglant la 
résolution de sortie de l’image. 

 
Dans l'exemple ci-dessous, notez l'utilisation des codes ‘@’ standard, ainsi que le code barre associé au champ @ID.  

 
 

Utiliser et définir les ‘Holes Punches’ (repères de coupe)  
NeoPack+ permet de gérer les repères de coupes en fonction de votre imageur.  Il existe deux types d'imprimantes 
supportées : 

• Les tireuses ‘rol to rol’ qui gèrent les pérforations,  

• Les tireuses sec à sec munies d’un système de découpe du papier.  

Dans le premier cas, vous pouvez définir un certain nombre de perforations par Layout.  Si vous utilisez un driver 
d'imprimante Windows NT, la position des perforations est envoyée à l'imprimante en même temps que l’image à 
imprimer.  
 



 

NeoPack + - Créer des ‘templates’  Page 43
 

Si votre imprimante ne gère pas les perforations ou qu’elle est équipée d’un système de coupe, vous pouvez utiliser 
des repères de coupe pour découper votre Layout à l’impression.  Dans ce cas, vous pouvez fixer des repères pour 
découper les longs packs.  Lors de l’impression, ils seront envoyés en plusieurs parties et sortiront donc en plusieurs 
planches.   
 
Perforations et types d'imprimantes  
Il y a plusieurs types d'imprimantes digitales : 

• Alimentation feuille à feuille,  

• Roll to roll, alimentation courte, 

• Roll to roll, alimentation longue.  

Une imprimante feuille à feuille possède une avance de papier maximum. Un bon exemple est la Sienna  FotoPrint 
qui a une taille maximum de sortie de 8x12’’ ou de 12x18’’selon le modèle.  
Une imprimante Roll to roll, alimentation courte utilise un système de filtre anti-aliasing.  Comme la précedente, 
cette machine possède une avance de papier maximum. Un bon exemple est la Kodak MultiPrinter qui ne dépasse 
pas le format 12x18".  
Une imprimante Roll to roll, alimentation longue  n'a aucune avance papier maximum (hormis la longueur du 
rouleau de papier).  Ce modèle d'imprimante peut créer des tirages très longs, dans la théorie, aussi long que le 
rouleau de papier utilisé.  Un bon exemple est la Gretag Mileca.  
 
Imprimantes Roll to Roll ou feuille à feuille  
Les imprimantes feuille à feuille n’ont pas de système de perforation, au contraire, elles coupent les feuille avant de 
les impressionner et les développent immédiatement.  
Les imprimantes roll to roll effectuent des perforations pour situer le début ou la fin d’une feuille.  Une fois que le 
rouleau de papier a été entièrement insolé, les impressions sont découpées au massicot éléctrique en suivant les 
perforations.  
Enfin, certaines machines peuvent placez des perforation à l’interieur même d’un modèle : vous pouvez vouloir créer 
un layout et le sortir comme quatre planches distinctes.   
 
Marques de coupe ‘hard’ et ‘soft’ 
NeoPack+ supporte 2 types de marques : 

• Marque soft - le modèle sera perforé par l'imprimante à l’endroit désiré,  

• Marque dure - NeoPack+ découpe le modèle en plusieurs planches.  

Pour pouvoir utiliser les marques soft, vous devez utiliser un driver d’imprimante fourni par Timestone sur une 
imprimante qui gère les perforations.  
A l’inverse, toutes les imprimantes gèrent les marques hard.  
 
Utilisation des marques ‘hard’  
Les repères de coupe ‘hard’ sont un outil très puissant.  Si vous travaillez sur une imprimante dont l’avance papier 
maximum est limitée, utilisez les marques de coupes ‘hard’ pour imprimer des modèles longs.  Vos modèles seront 
alors compatibles avec un très grand nombre d’imageurs.  
Ce principe vous permet aussi d’optimiser votre production.  En effet, chaine de production numérique a besoin de 
recevoir un flux de données continu pour maintenir l'imprimante occupée.  Or plus les modèles sont longs, plus ils 
sont lourds à caculer et donc plus la probabilité est grande d’avoir un trou entre chaque envoie vers l’imprimante.  
Utiliser les marques ‘hard’ créé des fichiers plus petits et permet donc de maintenir une file d’impression en charge.  
Par exemple, la Gretag Mileca gère sans problème le traitement de fichiers de 22Mb.  Si vous lui envoyez une série 
d’images de 60Mb, l’imprimante aura fini son travail d’impression avant que le fichier suivant ne soit calculé.  Elle 
va donc arréter l’avance papier ce qui provoque l’apparition d’une bande blanche et donc une gache de papier.  
Utilisez donc les marques de coupe ‘hard’ pour séparer les longs modèles en plusieurs fichiers de tailles plus 
réduites.  
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Définir des marques de coupes  
Les marques de coupes sont définies dans un ‘template’.  Vous pouvez en mettre autant que vous voulez, sachant que 
chaque imageur possède une distance minimale de coupe.  Consultez la documentation technique de votre materiel 
pour plus d’informations à ce sujet.   
 
Réglage de la position 
Décidez l’endroit où vous voulez placez votre marque de coupe.  Choisissez Edit > Cut marks.  La boite de dialogue 
Cut Marks s’ouvre.  
 
Ajouter une marque (punch)  
Choisissez New.  Une nouvelle ligne apparaît dans le tableau.  Choisissez si le repère doit être horizontal ou vertical.  
Puis indiquez la position de la marque.  
 
Choisissez le type de marque (punch type)  
Si vous voulez que la marque soit ‘hard’, verifiez que la case Hard est bien cochée.  Par défaut, le type de marque  
est fixé à ‘soft’, et si votre système d’impression ne le gère pas, cette marque sera ignorée.  
 
Ajouter des marques supplémentaires  
Si vous devez ajouter des marques supplémentaires, choisissez add.  Une nouvelle ligne apparaît dans le tableau Cut 
marks.  Faites vos modifications.  
Une fois que vous avez ajouté toutes les marques nécessaires, choissez OK.  

 

 

Affichage des marques 
Vous pouvez afficher une marque de coupe en cliquant sur le bouton Cut marks dans la barre des tâches 
Display Options.  L’affichage se fait par des poitillés rouges.    
 
 
 
 
 
 
 
          Marque de coupe Hard 

Marque de coupe Soft 
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Pack Item templates  
Un pack item template représente un groupe d'objets graphiques et de textes qui, positionnés sur un Layout, forment 
un ‘job’ d’impressoin. Un pack item template sera adapté dans le Layout sélectionné, et au besoin il sera coupé. Par 
exemple, vous pouvez créer un pack item template s'adaptant sur un 8x12" ou un 8x10".  Sur le premier, la mise en 
page sera placée plein cadre et sur le second, elle sera coupée en haut et en bas.  
Un Pack Item template peut contenir plusieurs images de tailles et 
d’orientations différentes.  Les images sont automatiquement retaillées et 
retournées pour venir se mettre à leur place.  
Les Pack Item templates peuvent contenir divers éléments graphiques 
comme des images bitmaps issues de Photoshop, et des dessins vectoriels 
WMF créés depuis CorelDraw ou Illustrator.  Ils supportent également les 
calques transparents, ce qui signifie qu’une couleur spécifique peut 
apparaître comme transparente.  Une image placée derrière un champ 
transparent sera visible comme à travers un cadre. 
Dans l'exemple, remarquez que la même mise en page a été placée dans une 
Layout de 8x10" et de 8x12".  Le  nounours apparaît par-dessus l’image, 
indiquant qu’un transparent a été utilisé.  
 

Créer un Pack Item template  
Pour créer un nouveau Pack Item template, passez en mode conception en choisissant mode > Template designer.  
Choisissez file > new, puis Pack Item dans la sélection. Un Pack Item template vierge est créé.  
 
Définir la taille du pack item template  
Fixez la taille de la page en cliquant sur le fond.  Notez l’apparition des poignées autour de la page signifiant que 
l’objet ‘feuille’ est actif.  Les champs de saisie size deviennent aussi actifs.  Une fois la taille entrée, appuyez sur 
Apply.  Les changements sont appliqués à la page.  Vérifiez que l’unité visible dans la liste de choix units est bien 
celle qui convient.  

 
Figure 13 : Page de fond avec les poignées  
 

Préparer et utiliser des images graphiques  
Il y a plusieurs étapes dans la création et le positionnement des images graphiques.  

• La conception de l'objet dans un éditeur des images,  

• Son intégration dans un ‘template’ de NeoPack+,  

• Définir les champs transparents si nécessaires.   

Il y a un certain nombre de choses importantes que vous devez conServeur à l’esprit en concevant votre image 
graphique pour l'utiliser dans un ‘template’.  
 
Bitmaps ou vectoriel ? 
Il y a deux types distincts d’images graphiques utilisées dans un ‘template’ de NeoPack+ : 

• Les dessins vectoriels issus par exemple de CorelDraw,  

• Les images bitmaps issues d’applications comme Photoshop.  
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Ces deux types sont différents dans la manière dont ils ont été créés, mais également dans leur rendu final à 
l’impression.  Un dessin vectoriel est constitué d’une série de lignes et d’un certain nombre de couleurs appliquées à 
certains champs de l’image.  Il est adapté pour les logos mais donnera toujours un aspect ‘cartoon’ à une image.  
A l’inverse, un bitmap conserve l’aspect réaliste d’une image réaliste.  
La grande différence entre un dessin vectoriel et un Bitmap vient de leur taille.  Un vecteur est très léger et 
s’imprime très vite, tandis qu'un Bitmap est plus lourd et donc plus lent à l’impression. Dans l'exemple ci-dessous, 
l'image de droite utilise un cadre bitmap, tandis que l’autre utilise un dessin vectoriel.  Le fichier bitmap pèse 
20,4Mb, contre 2Mb pour l’image vectorielle.  Les impressions ont duré respectivement 45 sec contre seulement 8. 

   

 

Taille des fichiers bitmaps  
Si vous voulez utiliser un cadre bitmap, vous pouvez optimiser le temps d’impression en prenant une image aussi 
petite que possible.  Si votre image possède des détails très fins - comme une texture - vous devrez utiliser une taille 
de fichier plus grande.  Dans tous les autres cas, vous pouvez limiter la taille de votre image.  Vous pouvez utiliser ce 
guide pour déterminer le ratio optimal poids/qualité.  
Ces recommandations concernent une taille maximum d'impression de 8x12" à 300dpi  
 

Detail Utiliser ce poids de fichier 

Peu de détail 2 – 4Mb 

Quelques détails 4 – 6Mb 

Détails importants 6 – 8Mb 

Très détaillé 10 – 20Mb, requiert des tests 
 

Format de fichier Bitmap 
NeoPack+ offre la gestion de la transparence sans dégradé.  Cela signifie qu'une couleur peut être définie comme 
transparente dans un cadre.  Par exemple, si vous désirez qu’un champ dont la couleur est définie par R = 255 G = 
255 B = 255 soit transparent, tous les objets blancs de votre cadre seront transparent.  
Vous ne pouvez donc pas utiliser le format JPEG pour vos cadres puisque celui-ci modifie la valeur d’une couleur en 
fonction des pixels voisins.  Pour vos cadres, vous utilisrerez donc le PNG, le TIFF ou le TARGA.  
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Champs transparents dans un cadre 
Pour utiliser la transparence dans un cadre, il faut être attentif au choix de la 
couleur.  En créant votre cadre, vérifiez bien que cette couleur n’est pas 
utilisée par une autre partie de l’image.   
Il faut aussi faire attention aux bords interieurs de votre cadre.  Beaucoup 
d’éditeurs d’images utilisent l’anticrénelage qui tend à adoucir le bord des 
séléctions.  Votre cadre apapparaît donc un peu flou dans votre ‘template’.  
Une ombre portée aura le même effet.  
 
Masques de 8 bits  
� Nouveau dans la version 2.0   

La nouvelle version de NeoPack+ autorise l’utilisation des masques transparents de 8 bits.  
Cela permet des effets de transparence ‘progressif’.  Utilisez un éditeur d’images comme 
Adobe Photoshop pour créer ces masques.  
Il est possible d’appliquer ces masques de tranparence sur tous les objets graphiques d’un 
‘template’.  
 
‘Trous’ dans des dessins vectoriels  
Les dessins vectoriels peuvent contenir des champs vides qui sont comme des trous.  
NeoPack+ conserve ce ‘trou’, et vous permet de créer des champs transparents dans un 
dessin vectoriel.  
La façon dont ce trou est créé dépend de l'application que vous utilisez.  Par exemple, avec CorelDraw, dessinez 
deux objets de couleur différente, et placez les l’un au dessus de l’autre.  Puis choisssez arrange > combine pour 
scinder les deux objets.  Un des objets va former un trou dans l'autre.  
Consulter votre manuel utilisateur pour plus d'informations.   
 
Placez des objets dans un Pack Item templates  
Les Pack Item templates peuvent contenir des objets graphiques, des trous d’images et des textes. Ils peuvent aussi 
contenir des images en portraits et en paysage.  La rotation se fait automatiquement lorsqu’un modèle est appliqué à 
une image.  
Les objets sont placés sur la feuille en cliquant sur le bouton correspondant de la barre d’outils Place object, puis en 
définissant une champ à la souris.  Les objets sont placés sur des calques ‘empilables’, leur permettant d'être 
positionnés devant ou derrière un autre.  
 
Plaçer et utiliser des ‘trous’ des images 
Les images que vous importez apparaissent dans les champs ou ‘trous’ (holes) que vous placez dans un ‘template’.  
Vous pouvez placez autant de trous désirez.  Ils peuvent être de différentes tailles et de différentes orientations.  
NeoPack+ gère automatiquement le placement d’une image dans un trou.  
Pour créer un trou d’image, cliquez sur le bouton Place image hole.  Le curseur change d’aspect.  
Placez la souris au-dessus de l’endroit de la page où vous voulez que le trou apparaisse.  Cliquez et 
déplacez votre souris sur la page.  La précision n’est par importante à cette étape.  La boite de dialogue 
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Placez un trou d’image  
Un trou d’image est un champ dans un pack Item template où une image doit apparaître.  Vous pouvez créer un pack 
item template contenant plusieurs images, avec ou sans cadre transparent.  Pour cela choisissez  image (au lieu de 
item design) pour placez une image à laquelle aucun cadre ne sera appliqué.  

 
 
Appliquer un virage à une image  
Vous pouvez choisissez d’imprimer une image en noir et blanc en sélectionnant as black & white ou de lui appliquer 
un virage par as sepia/colorized. 

 
Finissez en cliquant sur OK, le trou est placé sur le ‘template’.  
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Figure 14 : Un trou d’image est positionné sur un Layout 
 
Placez et dimentionner un objet avec précision  
Tous les objets peuvent être placés en utilisant la souris, ou en renseignant les champs Object Dimensions dans la 
barre d’outils.  Cliquez sur votre objet.  Notez qu’il s’active en affichant des poignées.  

 
Figure 15 : Un objet sélectionné  
 
Taille et positionnement des objets avec la souris  
Pour changer la taille d’un objet à la souris, cliquez sur une des poignées qui entourent l’objet actif et déplacez la 
dans la direction désirée.  Pour déplacez un objet, cliquez dessus et déplacez le tout en maintenant le click.  
 
Taille et positionnement des objets avec la barre d’outils  
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Figure 17 : Un trou d’image après avoir été agrandis  
Pour placez plusieurs trous d’image dans un ‘template’, recommencez ces actions autant de fois que nécéssaire.  
 

Placez et utiliser les objets graphiques  
Dans NeoPack+, plusieurs objets graphiques peuvent être placés dans un ‘template’.  Les étapes sont les suivantes.  
 
Placement d'un objet graphique  
Créez un nouveau ‘template’. Choisissez la taille de votre tirage final. Cliquez ensuite sur le bouton Place 
Graphic  Object. Le pointeur de souris change pour celui de positionnement.  
Cliquez et déplacez la souris dans le ‘template’.  Ne soyez pas précis pour l’instant.  Une boite de dialogue 
Ouvrir apparaît. Séléctionnez votre fichier puis cliquez sur open.  

 
Figure 18 : La boite de dialogue Open  
 
Maintenant, La boite de dialogue set Bitmaps mask s’ouvre.  Cliquez sur la couleur qui doit apparaître comme 
transparente.  Dans notre exemple, nous choisissons la partie blanche au centre. Vous n’êtes pas obligé d’utiliser une 
zone transparente, dans ce cas appuyez sur Cancel.  L’objet sera placé, mais aucune zone transparente ne sera créée.  
En cas d’erreur, le bouton Reset vous permet de revenir à l'état initial.  
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Une fois la zone transparente choisie, elle apparaît sous forme d’un cadrillage blanc.  

 

 
Figure 19 : Un objet graphique  
 
Placez et positionner un objet  
Séléctionnez l'objet.  Maintenez la touche Shift au besoin (si plusieurs objets sont séléctionnés).  Cliquez puis 
déplacez une des poignées à la souris pour agrandir ou diminuer la taille de vos objets.  Pour travailler avec plus de 
précision, sélectionnez un objet et modifiez les champs Offset et Size dans la barre d’outils.  N’oubliez pas 
d’appliquer vos modifications par Apply.  
 

Contrôler l’homothétie d’une image  
En plaçant un objet image dans un ‘template’, vous pouvez spécifier la façon dont il va s’afficher.  C'est important 
lorsqu’une image doit apparaître entièrement sans modification de son rapport hauteur/largeur.  

Il y a trois options disponibles : 

• Couper l'image en conservant les proportions,  

• Adapter l'image en conservant les proportions (des marges blanches peuvent apparaître), 

• Remplir le ‘trou’ d’image sans conServeur les proportions.   
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Vous pouvez utilisez les boutons de la barre d’outils Scaling options (option de mise à l’échelle).  
 
 
 

Remplir le cadre avec l’image sans conServeur les 
proportions 

Remplir le cadre avec l’image     Adapter l’image 
 
 
Changer les options de mise à l’echelle 
Une fois que l’objet graphique est placé sur la zone de travail, selectionnez l’option choisie dans la barre d’outils 
Scaling Options. 
 

Choix Resultat … 

Couper l'image pour remplir la zone en maintenant ses proportions 

 
 

Afficher l’image plein cadre dans la zone en maintenant ses proportions (des marges 
blanches apparaîtront) 

  

Remplir la zone avec l’image en déformant celle-ci 

 
 

 
Choisissez des objets sur d’autres calques 
Lorsque plusieurs objets sont placés dans un ‘template’, vous pouvez passer de l’un à l’autre à l’aide du clavier en 
utilisant la touche Tab.  Par exemple, si vous voulez sélectionner la feuille de travail et que celle-ci est totalement 
recouverte par d’autres objets, cliquez n'importe où puis appuyez sur Tab pour passer d’un objet à l’autre.  A chaque 
nouvel objet sélectionné, des poignées apparaissent.   

 
Figure 20 : Cycle entre les calques 
 
Changer l’ordre des calques  
Les objets peuvent être placés les uns devant les autres.  Cet ordre peut être modifié grâce à la palette d’outils Object 
Order.  Pour ce faire, sélectionnez un objet à la souris, puis le bouton correspondant au changement de position que 
vous désirez lui appliquer.  
 
 
 
 
 

Faire monter d’un niveau       Envoyer à l’arrière plan 

Faire monter d’un niveau       Envoyer au premier plan 
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Placez deux objets image sur la page, et assurez vous qu'ils se superposent.  

 
Figure 21 : L'objet sélectionné se trouve sur le calque supérieur  
 
Cliquez sur le bouton Send down (placez en arrière-plan) en selectionnant l’objet placé au-dessus.  Il se positionne 
derrière l'autre.  

 
Figure 22 : L'objet sélectionné passe un calque plus bas  
 
Fusionner des images : créer un ‘trou’ d’image  
On appelle un ‘trou’ la zone où apparaîtront vos images dans un template. Comme nous l’avons dit plus tôt, un autre 
moyen de définir ce champ est de définir une couleur comme étant transparente.  Dans notre exemple, c’est le blanc 
qui a été choisi.  Après avoir placé le cadre, cliquez sur le bouton Image Object dans la barre d’outils.  Le pointeur 
de souris change d’aspect.  Dessinez votre trou d’image au-dessus du cadre.  Il n'est pas nécessaire d'être trop précis.  
Notez que votre nouvel objet repose au-dessus du cadre.  

 
Figure 23 : Le trou d’image est placé au-dessus du cadre 
  
Le ‘trou’ d’image sélectionné (les poignées sont visibles), cliquez sur le bouton Send down (envoie en arrière-plan). 
Il passe donc sous le cadre. Notez que les poignées de l’objet sélectrionné sont toujours visibles.  
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Figure 24 :  Le ‘trou’ d’image se trouve sous le cadre 
 
Appliquez ce modèle à une image, l’image et le cadre fusionnent. 

 
 Figure 25 : L'épreuve finale  
 
Placez des objets graphiques supplémentaires  
Vous pouvez ajouter autant d’objet que vous le désirez. Il vous suffit de répéter les étapes décrites au-dessus.  
 
Masques de 8 bits  
 
� Nouveau dans la version 2.0   

La nouvelle version de NeoPack+ gère les masques transparents de 8 bits. Ils permettents des effets 
graphiques comme les cadres à bord floutés. Vous devez d'abord créer votre cadre dans un éditeur 
d’images comme Adobe Photoshop.  
 
Appliquer un masque de 8 bits à un trou d’image  
Après avoir placé un trou d’image sur la feuille de travail, sélectionnez le et appuyer sur le bouton apply 
8 bit Mask dans la barre d’outils. La boite de dialogue Set Mask s’ouvre. Choisissez load – Une autre 
boite de dialogue apparaît. Sélectionnez alors votre masque, puis appuyez sur Ouvrir. 
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Une ‘preview’ s’affiche ; vous pouvez appliquer une rotation au masque. Finissez en validant par Ok. Une ‘preview’ 
de l'image masquée s’affiche. Pour supprimer ce masque, appuyez sur Reset.   

 

 
 
 
 
 
 
 
 
 
 
‘Templates’ en portrait et en paysage  
Les images que vous utilisez avec NeoPack+ peuvent être soit verticales soit horizontales. Vos ‘templates’ 
contiennnent des trous d’image qui eux aussi peuvent prendre les deux orientations. Un problème se pose donc avec 
les cadres : si vous essayez de placez une image dans un cadre qui possède une orientation différente, votre photo 
sera systématiquement coupée.  
Pour résoudre ce problème, Neopack+ permet de concevoir une version verticale et horizontale d’un ‘Pack Item’. 
Lorsque vous appliquez cet Item à un Layout, le programme choisi automatiquement l’orientation correspondante.  
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Préparation des objets graphiques  
Dans votre éditeur d’images, créez les images nécessaires pour les deux orientations et sauvegardez  les sur votre 
disque dur.  
 
Créer une version pour chaque orientation  
Ouvrez NeoPack+ et passez en moTemplate Designer. Créez un nouveau fichier, et choisissez Pack Item 
dans la liste de choix. Cliquez sur le bouton Create Portrait/Landscape dans la barre des outils. Notez que 
les boutons Switch Orientation deviennent disponibles. En choisissant un des deux boutons, vous notez que 
l'orientation change. Chacune de ces orientations peut contenir des images, des textes statiques et/ou 
dynamiques.  
 
Choisissez l'orientation  
Choisissez une des orientations, et placez vos objets. Puis, changez d’orientation en cliquant sur le bouton  Switch 
Orientation. Une nouvelle page s’affiche. Ajouter tous les composants requis et vérifiez en passant d’une orientation 
à l’autre que votre ‘template’ est terminé.  
 
Enregistrer le fichier  
Une fois que votre ‘mise en page’ est terminée, donnez lui un nom en allant dans le menu le file > properties. 
Enregistrez le fichier, puis quittez et relancez le programme. Le nouveau ‘template’ est maintenant disponible. 
 
Utilisation d’un Pack Item  
Ouvrez un fichier (job file) qui contient des images en portrait et en paysage. Si vous ne possédez pas ce genre de 
fichier, créez un nouveau job et importez des images. Choisissez une image verticale, puis un Layout et enfin notre 
item. Notez que votre image est placée dans le ‘template’ vertical. Maintenant, choisissez une image horizontale et 
faites de même. L’item horizontal est utilisé.  
 

Utilisation des objets texte 
Vous pouvez ajouter du texte à vos ‘templates’ qu’il soit fixe ou dynamique. Des lignes de code permettent 
d’afficher le contenu des champs entrés pour chaque image d’un job. Le texte peut être formaté comme bon vous 
semble.  
NeoPack+ permet d'associer des textes aux images que vous importez. Vous pouvez ainsi insérrer le nom d’un élève 
d’une école ou un message personnel.  

Texte fixe et dynamique  
Il y a deux types de texte qui peuvent être placés dans un ‘template’ : 
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• Fixe : le texte apparaît toujours de la même façon, 

• Dynamique : le texte change à chaque image. 

A chaque fois que NeoPack+ croise le symbole ‘@’, il traite ce texte comme une ligne de code et essaye de lui 
associer une information correspondante. Si aucune information n'est disponible, ce texte est ignoré.  
 
Positionner des objets texte  
Créez un nouveau ‘template’ – un Layout ou un Item, peu importe. Choisissez l'outil Text Object de la barre 
des outims. Cliquez dessus et déplacez la souris sur le ‘template’ à l’endroit où le texte doit apparaître. La 
boite de dialogue Text s'ouvre. Entrez votre texte.  

 
Figure 26 : Boite de dialogue texte  

 
Figure 27 : Texte placé dans un ‘template’  
 
 
 
 
 
 
Sélection de la police 

Sélection de l’échelle 

Sélection de la taille 

Sélection du style 

Sélection de la couleur 

Sélection de l’alignement 
 
 
Choix de la police 
Choisissez le texte que vous souhaitez formater, puis la police dans la liste déroulante.  
 
Choix du style  
Choisissez le texte que vous souhaitez formater, puis appliquez lui un style.  
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Choix de l’alignement 
Choisissez le texte que vous souhaitez formater, puis l’alignement désiré.  
 
Contrôle de la taille des textes  
Par défaut, la taille du texte est fixeé automatiquement pour rentrer dans le cadre que vous avez dessiné. Cela permet 
aux textes longs de ne pas être coupés. Plus le texte est long, plus la taille de police diminue. 

 

 

Taille relative d’une police 
Vous pouvez contrôler la taille relative d’un texte en utilisant la commande Relative scaling. Si vous 
voulez qu'une partie du texte soit plus grande que le reste, sélectionnez  la, puis cliquez sur la flèche 
du haut. Cliquez sur la flèche du bas pour diminuer sa taille. 

 
 

 Créer un texte dynamique  
Les ‘templates’ de NeoPack+ utilisent le caractère réservé ‘@’ qui permet de personnaliser chaque ‘job’. Par 
exemple, vous pouvez imprimer une série de portrait avec le nom de la personne photographiée associé à un message 
personnel.  
Pour cela il suffit de faire précéder un nom de champ par la variable ‘@’ et Neopack+ fera automatiquement le lien 
avec l’image. Il est également possible d'importer des fichiers textes, à partir du moment où leur contenu a été 
formaté pour correspondre aux champs de chaque image.  
Pour l'exemple suivant, vérifiez que vous pouvez voir les 4 fenêtres principales de NeoPack+ comme dans la figure 
ci-dessous.  
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Fenêtre 
Add/view 

 
Fenêtre images 
 
 

 

 

 

 

 

 

   Fenêtre détails   Fenêtre file d’attente 
 

Créer et utiliser les codes ‘@’  
Un code ‘@’ est simplement un objet texte qui commence par le caractère ‘@’. Vous pouvez définir autant de codes 
‘@’ que vous voulez, tant qu’il correspond à un code de l’application.  
Dans l'exemple suivant, nous allons créer une page simple avec une image, contenant deux champs nom et prénom.  
 
Créer les champs par défaut  
Nous avons vu au chapitre 5, ‘configurer NeoPack+’, qu’il était possible de définir des champs qui utilisent le 
caractère ‘@’. Vous pouvez définir des champs par défaut qui se retrouveront dans tous vos nouveaux jobs.  
Si vous n’avez pas défini de champ par défaut, vous pouvez toujours en ajoutez au fichier en cours en choisissant 
Edit > Fields… La boite de dialogue Data Fields s’ouvre. Ajouter les champs que vous souhaitez utiliser suivant les 
indications du chapitre 5. Pour cet exemple, créez les champs suivants : 

• Prénom,  

• Nom  

• Message  

Cliquez sur Ok. Les champs que vous avez définis apparaîssent dans la colonne Fields de la fenêtre Details.  

 

 
Créer le ‘template’  
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Pour créer le code ‘@’, placez un objet texte suivant les étapes décrites plus haut, puis entrez le symbole ’@’ suivi 
du nom du champ correspondant.  
Dans le ‘template’, placez les codes suivants : 

• @First - pour placez le prénom  

• @Last - pour placez le nom  

• @Message - pour placez le message personnel  

  

Créer le code ‘@’  
Passer en mode Template designer en choisissant Mode > Template Designer. Ouvrez ou créez un nouveau 
‘template’ - un Layout ou un Item, peu importe.  
Cliquez sur le bouton Place Text object, et dessinez un cadre pour le texte sur le feuille de travail. La boite de 
dialogue Edit text s'ouvre. Écrivez le texte suivant : 

 
Choisissez Ok. Le texte est inséré dans le ‘template’. Ajoutez un ‘trou’ d’image, et pourquoi pas d'autres objets. 
Enregistrez  le ‘template’ et relancez NeoPack+.  

 
 
Utilisation du code ‘@’ 
Ouvrez un fichier qui contient quelques images importées. Maintenant, choisissez le ‘template’ que vous venez de 
créer, et un Layout au besoin. L'image est placée dans le ‘trou’ de votre ‘template’, mais aucun texte n'est pour le 
moment visible – puisque rien n’a encore été entré. Notez dans l'exemple ci-dessous que les champs field values 
sont vides.  
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Cliquez sur l’image à laquelle vous souhaitez ajouter le texte. Maintenant, selectionnez le champ prenom et donnez 
lui une valeur. Appuyez sur Entrée. Le texte apparaît dans la fenêtre Queue de NeoPack+. Procédez de la même 
façon pour les champs Nom et Message.  

 
 

Objets graphiques ‘marqués’  
Lorsque vous créez vos ‘templates’, vous pouvez placez un objet graphique ‘marqué’ pour simplifier votre flux de 
production. En effet, si vous voulez qu’un logo apparaisse sur chaque sortie, vous pouvez placez un objet contenant 
une référence à l’image du logo.  
 
Créer 'un objet ‘marqué’  
Pour ajouter un objet ‘marqué’, ouvez un ‘template’, choisissez le bouton Tagged object dans la barre des 
outils.  Utilisez la souris pour le placer dans le ‘template’. Il n'est pas nécessaire d'être précis. La boite de 
dialogue Edit Attribute s’affiche.  

 
 
Écrivez le code ‘@’  
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En fonction de la façon dont vous avez crée le ‘job’, vous pouvez avoir un champ par défaut dans la fenêtre 
principale de NeoPack+. Dans cet exemple, un champ SchoolLogo a été créé. Les graphiques ‘marqués’ doivent 
avoir le même intitulé que le nom du champ. La boite de dialogue Edit > Fields… s’affiche. Entrez le nom du champ 
dans Label et validez par OK.  

 

 
 
Contrôler l’homothétie d’un graphique ‘marqué’ 
Les images référencées par un graphique ‘marqué’ peuvent être considérées comme des images traditionnelles. 
Choisissez une option d’homothétie en sélectionnant l’option qui vous convient dans la barre d’outils.  
 
 
 
 

Remplir le cadre avec l’image sans conServeur les 
proportions 

Remplir le cadre avec l’image      
Adapter l’image 

 
Utilisation du graphique ‘marqué’  
Une fois que les codes ont été entrés, et qu’une image a été associée, les objets graphiques sont placés dans le job 
final créé en mode Main (F4).  
Dans cet exemple, nous avons placé un objet ‘marqué’ @SchoolLogo. Un champ SchoolLogo a également été 
défini pour ce fichier. Le logo se retrouve donc positionné sur le portrait.  
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Associer le logo avec le champ 
SchoolLogo … 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Le logo se retrouve sur 
le portrait. 
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8 
Créer un fichier ‘job’  

 
Une fois que vous avez créé vos Layouts et vos Pack Item, vous pouvez maintenant créer vos jobs avec NeoPack+. 
Pour cela, vous devez importer des images dans votre fichier ‘job’. Une fois importées, vous pouvez modifier les 
images (taille, couleur, densité), ajouter du texte, pour créer finallement des tirages prêts à être imprimés.  
Il est également possible d'importer des textes pré-formatés, ainsi que des commandes concernant un fichier ‘job’ 
donné. Cela signifie que vous pouvez automatiquement ajouter du texte, et construire vos tirages par l'intermédiaire 
du procédé d'importation.  
 

Options d'importation des images  
NeoPack+ importe les images que vous souhaitez utiliser dans votre fichier ‘job’. Le procédé d'importation crée une 
preview (vignette) qui est utilisée pour vous afficher une prévisualisation des tâches dans NeoPack+. La preview 
(vignette) est enregistrée en utilisant le format JPEG. 
 

 Créer un nouveau fichier dans NeoPack+  
Lancez l'application, puis choisissez  file > New, ou cliquez sur le bouton Nouveau de la barre des outils. La boite de 
dialogue New File s’ouvre. Choisissez un emplacement sur votre disque dur, donnez un nom au fichier et cliquez sur  
Save. Le fichier est sauvegardé, et un job vide s’ouvre.  
 

Indiquer la taille des preview (vignettes)  
La taille d’une preview (vignette) peut être changée depuis le menu options. La taille par défaut de 512k est 
normalement suffisante dans la plupart des cas, mais vous pouvez l’augmenter et améliorer l'aspect des vignettes. 
Sachez néanmoins que plus sa taille est grande, plus le ‘job’ est lourd. Il est aussi probable que l’application 
ralentisse si la preview (vignette) est trop lourde. La taille des vignettes doit être renseignée avant d’importer les 
images dans le job. 
Pour chager cette taille, choisissez  file > properties. La boite de dialogue des propriétés du fichier s’ouvre. 
Sélectionnez l’onglet Bitmap sizes, et entrez les informations voulues dans le champ Stored size of bitmap used 
for previewing.  
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Modes d’import des images 
Vous pouvez importer des images dans un job de plusieurs façons : 

• Importer l’image complète, 

• Importer seulement la vignette. 

Importer l'image complète  
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ImageServeur. Il dispose d’un lecteur partagé appelé Data, et toutes les images sont enregistrées dans un sous-
répertoire du dossier \Images.  

Les conventions UNC de nommage permettent d’accéder à ce répertoire depuis n'importe quel poste du réseau, sans 
utiliser de lettres de lecteur. Cela évite les erreurs de configuration. Le nom UNC pour le répertoire partagé  est 
\\Serveur\Share\Path.  
Vous pouvez placez vos images comme suit : 
\Images\Job1  
\Images\Job2  
\Images\Job3  
Seul le dossier racine est exigé. Dans notre cas, le dossier racine est \Images. Et donc, le nom UNC pour accéder à ce 
répertoire est : 
\\ImageServeur\Data\Images \  
Nous sommes enfin obligés d’indiquer le répertoire final pour trouver les images utilisées par le job. En utilisant le 
code ‘@+’, NeoPack+ ajoute le nom du fichier .TNJ (job) à la fin du chemin d'accès. Dans le cas ci-dessus, chaque 
fichier .TNJ est nommé Job1, Job2 et Job3.  
Ainsi, si le chemin d’accès est : 
\\ImageServeur\Data\Images\@+  
et que le job ouvert s'appelle Job2, NeoPack+ recherche les images dans : 
\\ImageServeur\Data\Images\Job2 \  
 
Le même répertoire que le fichier ‘job’  
Si le le chemin d’accès est : 
.  \ 
NeoPack+ recherche les images dans le même répertoire que le fichier .TNJ.  
 
Un sous-répertoire à partir du fichier ‘job’  
Les images peuvent être enregistrées dans un sous-répertoire du dossier qui contient le fichier ‘job’. Par exemple, si 
le fichier ‘job’ est enregistré dans le dossier  \Images\Job1, que ses images se trouvent dans \Images\Job1\Source, et 
que le chemin d’accès par défaut est : 
\Source,  
alors NeoPack+ cherche les images dans le sous-répertoire \Source.  
 
Images manquantes  
Si les images d’origine ne sont pas disponibles, un message d’erreur s’affiche. Pour résoudre le problème choisissez 
Retry pour relancer l’impression du ‘job’, ou Abort pour interrompre l’impression. 

 

 

Numérotation des images : indexé ou séquentiel  
Les laboratoires utilisant un grand nombre d’images disposent de systèmes différents pour les retrouver. Cela peut 
vouloir dire que les nom de fichiers sont indéxés suivant une partie de leur nom ou par un nombre inserré dans le 
nom du fichier. On les appelle des fichiers indexés. Toutes les autres images doivent être importées de façon 
séquentielle.  
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Images séquentielles  
En important des images séquentielles, il est important de conServeur l’ordre original, comme sur un film. Dans 
notre cas, les images sont  nommées dans l’ordre de prise de vue (ie 0001 - 9999).  Lorsque NeoPack+ les importe, 
l’ordre est conservé.  
 
Images indexées  
Beaucoup de laboratoires utilisent des appareils photo ou des systèmes d’archives qui associent un nombre unique à 
une image. Ce nombre peut alors être utilisé pour conServeur d’autres données utiles à la chaine de production du 
laboratoire. Par exemple, le système Lucht permet d’enregistrer des corrections de couleurs et d'autres informations 
qui sont utilisées pour le tirage final.  
Importer des images dans NeoPack+ provenant d'un système comme celui-ci, permet de conServeur ce nombre 
unique et de fonctionner comme dans une production traditionnelle.  
 
Indexé contre séquentiel  
Ces captures d'écran montrent un fichier indexé et un fichier séquentiel. Notez la différence dans la numérotation des 
images.  

 
Figure 28 : Images Indexées  

 
Figure 29 : Numérotation séquentielle  
 
Étiquette d’image  
Lorsqu’une image est importée, indépendamment du mode de numérotation, son nom du fichier est importé en même 
temps. Cette information peut être visualisée une fois que l’image a été importée en choisissant images > Show 
tags. Cette option permet d’afficher le nom de fichier à côté du numéro de l’image.  
 
 
 
 
Numéro de l’image        Nom du fichier 
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Numérotation des images  
Une fois que vous connaissez le système de numération, et avant d’importer les images, cliquez sur  file > 
properties. La boite de dialogue des propriétés du fichier s’ouvre. Sélectionnez le mode de numérotation indexé ou 
séquentiel.  
Il est possible de changer le type de numérotation de séquentiel en endexé et vice versa. Cependant, si un fichier 
indéxé est changé en séquentiel, tous les indexes sont détruits, et vous ne pourrez revenir en arrière.  

 
Figure 30 : Options de numérotation des images  
 

Indiquer le poids des images  
En important l’image complète dans un ‘job’, il est possible de fixer son poids à l’importation. C'est utile si les 
images sont trop lourdes par rapport à la taille du tirage final. Cette option ne fonctionne que si vous impotez une 
image complète ; dans le cas d’une preview (vignette), cette option est ignorée.  
Une fois le nouveau fichier créé, mais avant d'importer les images, choisissez file > properties …   Puis, 
selectionnez l’onglet bitmap sizes. Entrer le poids dans le champ Adjust to.  

 
Figure 31 : Poids des images par défaut  
 

Importer des images  
Une fois que les options du fichier ont été choisies, vous pouvez importer des images dans le fichier ‘job’. Choisissez 
images > images from disk. La boite de dialogue s’affiche.  
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Configuration de l'importation  
Il y a un certain nombre d'options disponibles à l’importation des images.  

• Le choix des fichiers à importer,  

• Définir un intervalle de noms de fichiers,  

• Appliquer une rotation ou une simétrie à l’importation,  

• Appliquer une correction de couleurs et de densité (LUT),  

• Ajouter de la netteté (sharpening) aux images.  

 
Définir les options d'importation  
Depuis le menu Images > Images from disk…, cliquez sur le bouton Setup. La boite de dialogue Images From 
Disk Setup s'ouvre. Elle est divisée en 4 parties.  

 

 

Choisissez le type d'importation  
Décidez si vous préférez importer une preview seule, ou toutes les données des images. Dans le premier cas, assurez-
vous que la checkbox Import preview only (importer seulement la vignette) est cochée. Puis, choisissez une des 
deux options permettant à NeoPack+ de retrouver les fichiers originaux au moment de l’impression.  
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• Remember the actual path of each image : NeoPack+ conserve en mémoire le chemin des images 

importées,  

• Discard the path… : NeoPack+ utilise le chemin de recherche par défaut défini dans les options du 

programme. 

Pour plus d'information concernant ces options, se référer au début du chapitre. 

  
Rotation/symétrie des images (rotation/flip) 
Si les images nécéssitent une rotation ou une symétrie, indiquez le ici.  
 

# Si vous importez juste une preview, le choix d'une de ces options augmentera le temps de traitement, 
puisque les calculs se feront au moment de l'impression. Pour optimiser au plus court vérifiez que vos 
images sont dans le bon sens avant de les importer. 

 

 
 
Appliquer un LUT  
Les images peuvent être corrigées en utilisant l'éditeur intégré des LUTs. Pour plus d'information sur comment 
utiliser le LUT, se réferrer plus loin dans ce chapitre. Sélectionnez le LUT que vous voulez utiliser dans la liste.  

 
 
Ajouter de la netteté 
Il est possible de rajouter de la netteté à l’importation. L'algorithme utilisé est un masque de sharpness donnant des 
bons résultats.  

 
Vous avez le choix entre : 
Kernel (grain) : 3, 5 ou 7  
Strength (force) : 10 - 600  
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Généralement, plus la taille de grain est grande, plus l'effet est fort. Idem pour la force. Plus la valeur de grain est 
haute, plus le temps de calcul est long.  
Il n'y a aucune valeur ‘correcte’ pour la netteté ; les valeurs que vous utiliserez dépendront toujours de l’image 
originale. Faites plusieurs tests avant d’importer les images pour trouver la meilleure configuration possible.  
 

# A chaque fois que vous appliquez un filtre comme celui du sharpen, vous augmentez le temps 
d’impression. Si vous employez un scanner, essayez d'utiliser les commandes intégrées plutôt que 
d'appliquer un filtre dans NeoPack+. De même avec un boitier numérique, vérifiez qu’il ne permet pas ce 
genre de traitement à la prise de vue. 

 
Une fois que la configuration est terminée, choisissez Ok. La boite de dialogue se ferme.  
 

Choisissez les fichiers à importer  
Il y a deux façons de choisissez les images à importer dans un ‘job’ : 

• Importer les images en utilisant un masque,  

• Selectionner les images à importer.  

Importer les images en utilisant un masque  
Si vos images sont numérotées à la suite, vous pouvez les importer en appliquant un masque sur le nom de fichier 
grâce à la boite de dialogue Import From Disk Masked.  
Depuis la fenêtre Images from Disk, cliquez sur le bouton Using mask… La boite de dialogue Import From Disk 
Masked s'ouvre.  
 
Choisissez le dossier image  
Entrer le chemin d’accès aux images à importer. Vous pouvez  parcourir (browse) l’arborescence des dossiers.  
 
Indiquer l'intervalle d’import  
NeoPack+ utilise un masque pour sélectionnez les fichiers à importer.  
Par exemple, un ensemble de fichier peut être nommé de la façon suivante : 

 
Ces noms de fichier se composent d'un préfixe, d’un nombre, puis d’un suffixe : 

• Préfixe : img  

• Nombre : 001 - xxx, 3 chiffres imposés  

• Suffixe : exp  

• Extension : tif  

Dans notre cas, il faut entrer : 

• ’Image’ comme préfixe,  

• ’3’ comme nombre,   

• ’exp’ comme suffixe,   

• ’tif’ comme extention.    
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Ainsi, tous les fichiers qui ne se conforment pas à ce masque seront ignorés. Si tous les champs sont laissés blancs, 
alors les fichiers bitmaps trouvés seront importés.  
 
Indiquer une limite d'intervalle 
Vous pouvez choisissez de contraindre l’intervalle des images à importer même si leur format est valide. Par 
exemple, pour importer les images de la n° 20 à la n°40 sur 100 fichiers valides, vous indiquez les valeurs 20 et 40 
dans les champs Limit : from image no… to image no. Les images 20 à 40 seront importées.  
Une fois la configuration terminée, cliquez sur Ok. La boite de dialogue Images From Disk Masked se ferme. Notez 
qu’à l’interieur de la fenêtre Images From Disk, vous pouvez voir une liste de fichiers.  

 
 
Sélectionner les images à importer 
Vous pouvez aussi importer vos images simplement en utilisant la boite de dialogue selected… Appuyez donc sur le 
bouton selected… La boite de dialogue Import From Disk s'ouvre. Choisissez les fichiers que vous voulez importer. 
Vous pouvez utiliser des raccourcis clavier de Windows. Par exemple :  

• < Shift > Click premier puis dernier fichier d’un intervalle - sélectionne un bloc de fichiers.  

• < CTRL > Click chaque fichier que vous souhaitez importer - ajoute les fichiers à la liste un par un. 

• < CTRL > A sélectionne tous les fichiers du dossier. 

 
Sélectionnez vos fichiers puis cliquez sur Ok.  

 
 

Indiquer l’ordre d'importation des images  



 

NeoPack + - Créer un fichier ‘job’  Page 74
 

Ouvrir le panneau ‘options d'importation’ en choisissant images > import options… Notez l’état de cette boite de 
dialogue. Si le job ouvert contient des images indexées, les options sont indisponibles. Si le job ouvert est séquentiel, 
les options seront disponibles.  

 
Options indisponibles pour un fichier 
indexé 

Options disponibles pour un fichier séquentiel 

 
Les bitmaps importées dans un job séquentiel sont renumérotées. Les images sont importées dans l’ordre en fonction 
des paramètres entrés dans la boite de dialogue Import options panel.  
Une fois les images importées, elles sont renumérotées de 1 à x en fonction du nombre d’images (1, 2, 3, 4…)  
Il y a plusieurs options d'importation disponibles : 

• Ordre inverse (Reverse Order) : Importe des images dans l’ordre inverse des numéros (de 999, à 001)  

• À la fin (To end) : Ajoute chaque nouvelle image à la fin de la liste. Si Reverse Order est sélectionné, les 

images sont ajoutées en début de liste.  

• Insertion (Insert) : Insert la nouvelle image après l’image sélectionné dans la fenêtre Images de NeoPack+ 

(disponible uniquement si la liste n’est pas vide).  

• Substituer (Replace) : Les fichiers importés remplacent des images déjà importées après l’image 

sélectionnée dans la fenêtre Images de NeoPack++ (disponible uniquement si la liste n’est pas vide).  

 

# Si l’option Insert est sélectionnée, des images sont insérées à partir de l’image sélectionnée dans la 
fenêtre Images de NeoPack+. Si vous sélectionnez une nouvelle image pendant l'importation, le 
processus d’insertion est maintenu. Si vous voulez changer l’endroit d’insertion, vous devez arrêter 
temporairement l'importation en choisissant pause import, choisissez un nouvel emplacement, puis 
cliquez à nouveau sur insert dans le panneau Import options panel.  

 
Démarrer l'importation  
Une fois que la configuration est faite, choisissez Start. L’importation 
commence. Choisir Stop durant le processus d'importation arrêtera l'importation 
après le fichier en cours. La boite de dialogue Images from disk peut être cachée 
en appuyant sur Hide. Les images continueront d’être importées jusqu'au dernier 
fichier sauf en cas de pause ou d’arrêt.  
 
Pause pendant l'importation  
Si vous souhaitez arrêter momentanement l’importation, cochez la case Pause 
import. L'importation des images est mise en pause jusqu'à ce que la case soit 
décochée.  
 
 

Le panneau Import options panel 
NeoPack+ vous permet de modifier les images pendant qu'elles sont importées. 
Pour cela utilisez le panneau Import options. Cette fenêtre peut être fermée sans 
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interrompre l’importation. 

 
 
Pause pendant l'importation  
Si vous souhaitez arrêter momentanement l’importation, cochez la case Pause import. L'importation des images est 
mise en pause jusqu'à ce que la case soit décochée.  
 
Contrôler l’import des images  
Vous pouvez suivre l’importation des images les unes après les autres. Les noms de fichiers s’affichent au fur et à 
mesure, accompagnés de leur preview.  
 

Distinguer une image importée d’une image liée  
Vous pouvez savoir si une image a été importée comme preview ou comme image entière en examinant son 
étiquette. Depuis le menu images vérifiez que l’option show tags est cochée. Les fichiers joints (preview) 
afficheront l'extension du fichier, les fichiers importés non.  

 
Figure 32 : différence entre une image liée et une image importée  
 

Autres sources d’importation 
NeoPack+ permet aussi d’importer des images depuis d’autres sources. La boite de dialogue Images from disk peut 
être cachée en appuyant sur Hide. Les images continueront d’être importées jusqu'au dernier fichier sauf en cas de 
pause ou d’arrêt.  
 
Configurer l'importation  
Choisissez Setup depuis la boite de dialogue Images From Hot Source. La fenêtre s’affiche. Les images peuvent être 
modifiées (rotation/symetrie) comme pour une importation traditionnelle. Ces réglages sont abordés plus haut dans le 
manuel.  

 

 

Indiquer un LUT  
Les images peuvent être corrigées en utilisant l'éditeur intégré des LUTs comme lors d’une importation 
traditionnelle. Par exemple, si vous savez qu’une série d’images est éclairé par une source lumineuse particulière, 
vous pouvez leur appliquer une correction à l’importation.  
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Choisissez le LUT dans la liste. Réferrez vous aussi au chapitre 10 pour plus d’information sur la calibration des 
couleurs.  

 

 

Importation depuis le presse-papier de Windows  
Si vous possédez une application ou un scanner qui place les images dans le 
presse-papier (clipboard) de Windows, NeoPack+ peut importer ces images 
automatiquement.  
Choisissez image > Import from hot source… Une boite de dialogue 
s'ouvre. Assurez-vous que clipboard est coché, et que pause ne l’est pas. 
Dans cette configuration, toutes les images qui apparaissent dans le presse-
papier (clipboard) de Windows sont ajoutées au job ouvert. Les images sont 
insérées en fonction des options choisies dans Options panel.  
 
Importation depuis un périphérique Kinetic bitmap 
Certaines applications utilisent ce principe d’échange d’images. Si votre périphérique est compatible, les images 
seront insérées automatiquement en fonction des options choisies dans Options panel.  Si vous n'êtes pas sûr que 
votre périphérique soit compatible, vérifiez avec le logiciel Timestone.  
 
Importation de fichiers indexés 
Si le job ouvert contient des images indexées, NeoPack+ importera seulement les images qui sont conformes au 
format d’import.  

 
Figure 33 : Panneau d'importation des images indexées 
  

Facteurs modifiant le temps d’importation des images  
NeoPack+ effectue certains calculs sur chaque image pendant l’importation. Cela signifie que l’importation de 
chaque image peut prendre plusieurs secondes. Cette durée dépend de plusieurs facteurs : 

• La vitesse du PC,  

• La quantité de mémoire installée sur le PC,  

• La Taille des images importées,  

• Les modifications demandées dans les options d'importation (rotation/symétrie)  

Pour réduire le temps au maximum, essayez de ne pas appliquer d’opération  lors de l’importation.  
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Modifier les images pendant l’importation  
Il est possible de modifier des images (zoom, recadrage et correction des couleurs) pendant l’importation. Mais 
l’application ne gère alors plus parfaitement les messages de la souris. Nous vous conseillons donc d’effectuer vos 
modifications en utilisant le clavier.  
L'importation des images peut toujours être contrôlée, même si la fenêtre d’import est masquée. Ouvrez le panneau 
d'options d'importation en choisissant Images > Import options panel…. Cette petite fenêtre peut rester à l'écran 
pour pouvoir arrêter ou relancer l’importation.  
 
 

Gestion des images importées 
Une fois que les images ont été importées dans NeoPack+, vous pouvez en ajouter, en supprimer ou en désactiver. 
Des images vierges peuvent aussi être insérées pour permettre de gérer le problème des élèves absents. 
 

Ajouter des images  
Vous pouvez ajouter ou remplacer des images dans un job. Utilisez le menu  images > import from disk. Les 
options disponibles changent selon que les fichiers sont indexés ou numérotés de façon séquentielle.  
 
Ajouter des nouveaux fichiers à la fin d'un job existant - fichiers séquentiels 
seulement  
Choisissez images > Import options panel…. Puis  to End (à la fin) comme choix pour  Incoming images. 
Indiquez les fichiers à importer. Les images seront ajoutées à la fin du job.  

 
 
Insérer ou remplacer des images dans un job - fichiers séquentiels seulement  
Pour ajouter des images au milieu d'un job existant, choisissez d'abord l'image à partir de laquelle les autres doivent 
être insérées ou remplacées, puis choisissez  images > Import options panel…. Notez que les options insert 
(inserrer) et replace (remplacer) sont disponibles.  
Les images importées avec l’option select sont ajoutées à partir de l'image en cours. Les images importées avec 
l'option replace remplacent les images existantes à partir de l'image en cours.  

 
 
Ajouter des images à un fichier indexé  
Toutes les images ajoutées à un job indexé sont ajoutées, insérées ou remplacent des images existantes, en fonction 
de leurs noms de fichier. Si une image porte le même nom qu’une image déjà importée, la nouvelle image écrase 
l’ancienne. Si son nom n'existe pas, elle est ajoutée au fichier.  
Les options Incoming images ne sont pas disponibles avec les fichiers indexés.  
 

Désactiver des images 
Les images peuvent être actives ou inactives. Si une image est inactive (Off), aucun pack ne pourra lui être affectée. 
C’est assez utile pour les photos d’ardoise et les ‘yeux fermés’. Dans ce cas, sélectionnez une image et allez dans le 
menu Images > Turn selected off 
Les images inactives peuvent cependant être éditées et recadrées.  
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Effacer des images  
Vous pouvez supprimer une ou plusieurs images en allant dans le menu image puis  > Remove selected. Un 
message de confirmation apparaît, puis les images sont supprimées.  

 
 

Fermer et compresser le job  
Fermez un fichier en choisissant File > Close, ou en cliquant sur le bouton fermer dans la barre des outils.  
Lorsque vous supprimez des images dans l’application, elles ne sont pas physiquement supprimées, bien qu'elles ne 
soient plus disponibles. La taille du job reste la même, que toutes les images soient effacées ou pas.  
Vous pouvez libérer cet espace en choisissant file > Close & compact. Cette option est un peu longue, et demande 
autant d’espace disque que la taille du fichier job. Une fois ce travail terminé, le job ne contiendra que les données 
utiles aux images, et il sera aussi petit que possible.  
Il est recommandé de ne choisir cette option que si beaucoup d’images ont été effacées.  
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9 
Modifier les images  

 
Une fois que des images ont été importées dans NeoPack+, elles peuvent être modifiées de diverses façons : 

• Zoom,  

• Recadrage (mouvement en x/y),  

• Corrections de couleur et de densité,  

• Corrections de contraste,  

• Editée par l'intermédiaire d'une application externe. 

Il y a beaucoup de raccourcis permettant de réaliser ces corrections, de même qu’il est possible de changer le nombre 
et la taille des images affichées. 
 

Modifier l'affichage  
Par défaut, NeoPack+ affiche chacune des trois fenêtres principales : 

• Images, 

• Packs, 

• File d'attente (Queue)  

Il est possible de changer le nombre et la taille des images du job. 
 

Commandes d’affichages de chaque fenêtre  
En bas à gauche des fenêtres d’affichage des images et de la file d’impression (Queue) se trouvent quatre boutons. Ils 
commandent les options d’affichage.  
 
Barre d’outils 
 
 
 
 
 

Image unique Verrouiller l'affichage 
 

Images multiples Choix du nombre d’images 
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Figure 34 : La fenêtre des images en mode images multiples et image unique  
 
Changer le nombre d’images affichées  
Cliquez sur le troisième bouton qui vous permet de choisir le nombre d’images qui apparaît dans la fenêtre, une grille 
apparaît. Déplacez la souris pour augmenter ou diminuer le nombre de cases dans la grille.  
 
Verrouiller l'affichage des images  
Cliquez sur Lock display et verrouillez le nombre de cases de la grille. Sans cette option le fait 
d’agrandir la fenêtre Images engendre une remise à l’échelle des vignettes.  
Cela signifie que si vous choisissez d'afficher les images suivant un carré de 2x2, la grille étant 
déverrouillé, le fait de changer la taille de la fenêtre ne change pas le nombre d’images affichées, mais 
change leur taille.  
Si la grille est verrouillée, la taille des vignettes est conservée, quelle que soit la taille de la fenêtre.  

 
Figure 35 : La grille – second bouton coché puis fenêtre agrandie. 
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Figure 36 : La même grille qu’au-dessus, mais vérouillée cette fois. 
  

Sélection des images  
Il est rapide et facile de naviguer dans la fenêtre Images. Choisissez d’abord une image en cliquant dessus.  
 

Action Clavier Souris 
Selectionner la première image Appuyez sur la touche Home 
Selectionner la dernière image Appuyez sur la touche End 

 

Afficher le prochain écran d’images Appuyez sur la touche Page suivante Utiliser la roulette 
Afficher l’écran d’images précédent Appuyez sur la touche Page précédente Utiliser la roulette 
Passer à l’image de gauche Appuyez sur la flèche de gauche 
Passer à l’image de droite Appuyez sur la flèche de droite 
Passer à l’image du dessus Appuyez sur la flèche haut 
Passer à l’image du dessous Appuyez sur la flèche bas 

 

 

Zoomer et recadrer  
Vous pouvez recadrer une image et modifier son rapport d’agrandissement. NeoPack+ peut afficher les repères 
d’homothétie du papier pour vous montrer comment votre image va être coupée. 
Il y a plusieurs façons différentes de redimentionner et de couper une image. Les valeurs de zoom et de découpage 
sont affichées dans la palette Image Corrections. Si la palette Image Corrections n'est pas visible, choisissez View 
> Image Corrections. Visualisez les rapports d’homothétie en sélectionnant Images > Select crop & scale image 
tool.  
Notez que toutes les images de la fenêtre affichent maintenant les rapports d’homothéties disponibles.  
 
Découpage des Images  
Choisissez une image. Elle peut être recadrée de la façon suivante : 
 

Action Clavier Souris Palette de correction 

Déplacez une image vers 
la gauche <Ctrl> + Í Cliquez sur et déplacez à 

la souris 

Entrez une valeur dans le 
champ ‘X’ ou appuyez sur 
<Ctrl> X + Ï 

Déplacez une image vers 
la droite <Ctrl> + Î Cliquez sur et déplacez à 

la souris 

Entrez une valeur dans le 
champ ‘X’ ou appuyez sur 
<Ctrl> X +  

Déplacez une image vers 
le haut  <Ctrl> + Ï Cliquez sur et déplacez à 

la souris 
Entrez une valeur dans le 
champ ‘Y’ ou appuyez sur 
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<Ctrl> Y + Ï 

Déplacez une image vers 
le bas  <Ctrl> +  Cliquez sur et déplacez à 

la souris 

Entrez une valeur dans le 
champ ‘Y’ ou appuyez sur 
<Ctrl> Y +  

 
Redimentionner une Image 
Choisissez une image. Elle peut être modifiée comme suit : 
 

Action Clavier Souris Palette de correction 

Agrandir l’image <Ctrl> + Ï <Ctrl> + roulette de souris 
Entrez une valeur dans le 
champ ‘S’ ou appuyez sur 
<Ctrl> S + Ï 

Diminuer l’image <Ctrl> +  <Ctrl> + roulette de souris 
Entrez une valeur dans le 
champ ‘S’ ou appuyez sur 
<Ctrl> S +  

 
Déplacer l’image en dehors de son champ d’impression  
Il est possible de déplacez les images en dehors de leur champ d’impression. Ce qui  pourrait engendrer l’apparition 
de marges blanches. Dans ce cas, vous verrez apparaître des flèches. Elles indiquent l’endroit où une marge blanche 
s’imprimera.  

 
 
 
 
 
 
 
L’image est hors de son champ d’impression  
 
 
 

Redimentionner et découper dans la pratique  
Fixer la taille et la position des images en fonction des formats d'impression est une tâche importante. Si plusieurs 
images nécessitent d’être modifiées, il faut que cela se fasse rapidement et précisemment.  
Dans la pratique, certains préfèrent utiliser le clavier pour faire ces réglages, d’autres la souris.   
 
Utilisation de la souris et du clavier.  

• Sélectionnez l'image à modifier,  

• Maintenez la touche <Ctrl> enfoncée et la roulette de la souris pour redimentionner l'image.  

• Lachez la touche <Ctrl>, puis ajustez la position à la souris,  

• Cliquez sur l’image suivante et répétez l'opération.  

 

# Notez que vous pouvez configurer le pas de la roulette de souris. Si le pas est fixé à 1, la grille avancera 
d’une ligne. S'il est placé à 3, la grille avancera de 3 lignes.  
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Utilisation du clavier  
• Sélectionnez la première image en appuyant la touche HOME.  

• Choisissez l'image à ajuster avec les flèches de déplacement.  

• Maintenez la touche <Ctrl> et utilisez les flèches de déplacement pour bouger l'image.  

• Maintenez la touche <Ctrl> et utilisez les touches de défilement de pages   ou   pour redimentionner 

l'image.  

• Employez les flèches de déplacement pour choisissez l’image suivante à modifier.  

• Utilisez  ou  pour afficher la série d’image suivante ou précédente.  

 

Ajustement de la couleur, de la densité et du contraste  
La couleur, la densité et le contraste des images peuvent être changées en utilisant les commandes de densité de la 
palette d’outils. Les corrections sont appliquées soit par lot, soit individuellement.  
 

# Ces réglages doivent d’abord être gérés par votre logiciel de scan. Les réglages dans NeoPack+ doivent 
se limiter au maximum pour assurer une qualité optimale en sortie.  

 
   

Action Clavier Palette de Correction 

Augmenter la luminosité <CTRL> + <I> + Ï 
Cliquez sur dans le champ I ou 
appuyez sur <CTRL> + I puis 
augmentez la valeur 

Baisser la luminosité <CTRL> + <I> +  
Cliquez sur dans le champ I ou 
appuyez sur <CTRL> + I puis 
diminuez la valeur 

Augmenter le contraste <CTRL> + <C> + Ï 
Cliquez sur dans le champ C ou 
appuyez sur <CTRL> + C puis 
augmentez la valeur 

Baisser le contraste <CTRL> + <C> +  
Cliquez sur dans le champ C ou 
appuyez sur <CTRL> + C puis 
diminuez la valeur 

Plus de rouge <CTRL> + <R> + Ï 
Cliquez sur dans le champ R ou 
appuyez sur <CTRL> + R puis 
augmentez la valeur 

Plus de Cyan <CTRL> + <R> +  
Cliquez sur dans le champ R ou 
appuyez sur <CTRL> + R puis 
diminuez la valeur 

Plus de vert <CTRL> + <G> + Ï 
Cliquez sur dans le champ G ou 
appuyez sur <CTRL> + G puis 
augmentez la valeur 

Plus de Magenta <CTRL> + <G> +  
Cliquez sur dans le champ G ou 
appuyez sur <CTRL> + G puis 
diminuez la valeur 

Plus de bleu <CTRL> + <B> + Ï 
Cliquez sur dans le champ B ou 
appuyez sur <CTRL> + B puis 
augmentez la valeur 

Plus de jaune <CTRL> + <B> +  
Cliquez sur dans le champ B ou 
appuyez sur <CTRL> + B puis 
diminuez la valeur 
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Retoucher l'image  
Souvent il peut y avoir de petits défauts sur les images comme des rayures ou des poussières. NeoPack+ vous permet 
de corriger ces défauts grâce à un lien avec un éditeur d’image externe comme Adobe Photoshop.  
Tous les changements effectués sur l'image depuis Photoshop sont alors répercutés dans NeoPack+. Photoshop est un 
éditeur extrêmement complet. Veuillez consulter votre le guide d’utilisation fournis par Adobe pour plus 
d'informations concernant Photoshop.  
 

Choix de l'éditeur et du format des images  
N'importe quel éditeur récent peut être utilisé pour modifier les images. En cas de modification par ce biais, 
NeoPack+ sauvegarde le fichier sur le disque au format Photoshop, ou Windows BMP.  
Si votre éditeur des images supporte le format PSD, nous vous recommandons de l’utiliser. Si vous utiliser des 
calques dans Photoshop, et que vous voulez sauvegarder au format BMP, il faut d’abord aplatir l’image.  
 

# Si l'image est enregistrée sous un nouveau nom, NeoPack+ ne poura pas charger les modifications.  

 
Retoucher une image  

• Choisissez l'image que vous souhaitez modifier,  

• Choisissez Edit image… depuis le menu images ou pressez <Ctrl> + E.  

• L'image est chargée dans l'éditeur d’images,  

• Effectuez vos modifications,  

• Enregistrez  le fichier et quittez l'éditeur, 

• L'image éditée est rechargée dans NeoPack+.  

¶ 
Configurer Photoshop  
NeoPack+ lit le format 2.5 dePhotoshop. Ces fichiers ne contiennent aucune information sur les calques, car ils sont 
apparus avec Photoshop 3.0. Normalement, lorsque vous introduisez des claques puis aplatissez l’image dans 
Photoshop, le fichier reste compatible avec le format  2.5.  
Lorsqu’une image contenant des calques est ouvertes dans NeoPack+, un message d'erreur apparaît. Si cela vous 
arrive, verifiez la compatibilité avec le format 2.5 en choisissant Saving files… depuis le menu préférences de 
Photoshop.  
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Si vous n’autorisez pas la compatibilité au format 2.5, vous verrez une fenêtre semblable à celle-ci. 
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10 
Créer des jobs dans NeoPack+  

 
Une fois que les ‘templates’ ont été créés, les options de l’application définies et les images importées, vous pouvez 
commencer à créer des ‘jobs’. Un ‘job’ est créé en sélectionnant une image, un Layout puis éventuellement un 
champ texte et un Item. NeoPack+ place automatiquement l’image dans le modèle choisi avec les textes ou les codes 
barres si nécessaire. 
Ceci fait, vous pouvez regrouper vos impressions dans des files d'attente (queues)  pour plus de confort d'utilisation. 
Si vous utilisez plusieurs largeurs de, NeoPack+ vous permet de définir plusieurs files d'attente qui permettent de les 
regrouper en différentes productions.  
Les champs textes utilisés dans chaque image d’un ‘job’ peuvent être renseignés à la main. Si ces informations sont 
stockées dans un fichier texte, et que celui-ci est pré-formaté pour coïncider avec les champs définis dans NeoPack+, 
vous pouvez importer ces données, en évitant le travail de saisie.  
De même, si vous possédez  les informations concernant une commande dans un fichier, vous pouvez 
automatiquement créer une nouvelle file d'attente.  
 

Créer une nouvelle file d'attente 
Leur emploi est facultatif. Si votre production ne nécessite pas plusieurs  largeurs de papiers, ne créez pas de files 
d'attente supplémentaires.  
 
Créer une file d'attente  
Ouvrez le fichier ‘job’ dans lequel vous souhaitez ajouter la file d’attente. Choisissez 
édit > Queue… .La boite de dialogue Queue list… s'ouvre.  
Choisissez New ; une nouvelle ligne apparaît dans la liste. Entrez un intitulé dans la 
colonne Description. Cliquez sur  Default Pack Set. Une liste avec tous les modèles 
disponibles (ceux qui existent par défaut et ceux que vous avez créés) apparaît.  
L’ordre d’apparition dans la fenêtre principale de NeoPack+ peut être changé en 
utilisant les deux boutons en bas de la liste. 
Choisissez Ok. La liste se ferme. Les files d'attentes sont maintenant disponibles par 
l'intermédiaire de la liste Queue. Naviguez entre les files d'attente en cliquant sur la 
liste et en choisissant une file d'attente différente. Toutes les pages créées dans la file 
d'attente précédente sont remplacées par celles de la nouvelle.  
 

Créer les ‘jobs’  
Construire des tirages dans NeoPack+ implique d’entrer les champs textes, de choisissez un Layout et 
éventuellement un Item. Vous pouvez effectuer ces étapes manuellement, au clavier, ou en important des fichiers 
textes.  
Les textes et les commandes peuvent être importés à partir de fichiers, permettant ainsi au traitement du ‘job’ d’être  
automatique. Vous pouvez également utiliser un lecteur de code barre pour produire des travaux si les informations 
de commande ‘répondent’ à des codes barre.  
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En créant un job, les futurs tirages sont ajoutés à la file d’attente. Si vous désirez plusieurs exemplaires d’une même 
image, elles sont regrouppés à la suite dans la file d'attente. Si vous modifiez des paramètres dans les palettes 
Crop/Scale ou Color, les changements sont pris en compte automatiquement sans action supplémentaire.  
 

Ajouter des textes  
Si vos ‘templates’ utilisent des données texte, vous devez soit saisir ces données manuellement pour chaque image, 
soit importer les données à partir d'un fichier.  
 
Saisi des données manuellement  
Ouvrez le fichier dans lequel vous souhaitez ajouter des données texte, puis selectionnez la première image. Assurez-
vous que la fenêtre Details est visible. Vous verrez les champs définis pour ce job dans cette fenêtre (en bas et à 
gauche). Si vous ne voyez aucun champ, réferrez vous au chapitre 5, ‘configurer NeoPack+’. Cliquez sur la première 
image qui nécessite du texte. Notez que le champ devient actif. Cliquez sur dans la colonne value, puis tapez votre 
texte. Continuer jusqu'à ce que toutes vos images soient renseignées.  

 
 
Ajouter des champs temporaires 
Si vous voulez utiliser rapidement un champ, et que vous ne voulez pas saisir dans Edit > Fields, vous pouvez le 
créer directement dans la liste. Il est alors provisoire. 
Par exemple, vous voulez utiliser un ‘template’qui nécessite un champ que vous n'utilisez pas habituellement -  le 
nom d'un animal de compagnie. NeoPack+ vous permet de choisissez une image, et d’entrer directement le nom du 
champ temporaire et sa valeur. Si le nom du champ apparaît dans le ‘template’, son contenu sera affiché sur l’image.  

 
 
Créer des champs pour plusieurs images 
Vous pouvez créer des champs pour un certain nombre d’images. Cela peut servir si vous devez indiquer le nom 
d’une classe ou d’un groupe etc… 
Pour ce faire sélectionnez un groupe d’images, puis ajoutez  le champ Details. Entrez une valeur ou choisissez un 
logo.  



 

NeoPack + - Créer des jobs dans NeoPack+  Page 88
 

 
 

Importation des données textes  
Si votre job nécessite des données externes, elles peuvent être importées dans NeoPack+. Ces données peuvent être 
contenues dans un fichier à longueur fixe ou variable. Les données sont mises en relation avec les images en utilisant 
leur numéro ou leur nom de fichier.  
Le fichier texte doit être de longueur fixe, ou variable, avec un retour chariot à chaque fin de ligne. Par exemple : 

Vanessa,Claridge,Happy Christmas,26/01/89,img001.tif 

Phyllis,Wills,Holidays are great!,7/5/89,img002.tif 

Andrea,Stratton,Wish you were here,10/2/89,img003.tif 

 Le délimiteur de champ est la virgule et chaque ligne contient 5 champs : 

• Prénom - champ 1  

• Nom - champ 2  

• Un message personnel - champ 3  

• Date de naissance - champ 4  

• Le nom de fichier correspondant - champ 5  

 
Sélectionnez le fichier à importer  
Pour importer ces données, ouvrez le job dans lequel vous souhaitez effectuer l’importation, puis choisissez  Details 
> Import text file… La boite de dialogue Text file to import details s'ouvre. Naviguez dans l’arborescence pour 
localiser votre fichier texte, puis cliquez dessus.  
 

Configurer l'importation  
Dans la boite de dialogue Text file to import details de détails, cliquez sur Setup. La boite de 
dialogue Setup image details text file import s'ouvre. Elle est divisée en plusieurs parties : 

• Type - indique le format de fichier que vous importez,  

• Field map - vous permet d'indiquer les positions des champs,  

• Match on - Choisissez la correspondance par le numéro des images ou par le nom de 

fichier,  

• Imported/existing image details - contrôle comment les données existantes vont être 

fusionné avec de nouvelles données.  

¶ 
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Choisissez le type  
Il y a plusieurs formats de données que vous pouvez utiliser. Ils vous permettent de délimiter les champs. Ceux sont 
les suivants : 

• Longueur fixe - chaque champ a une longueur fixe,  

• Longueur variable – la fin de chaque champ est indiquée par un délimiteur.  

Choisissez le format du fichier que vous préférez.  
 
Longueur fixe  
Si vous importez un fichier de longueur fixe, indiquez la position de chaque champ dans le fichier. 

  
 
Longueur variable  
Si vous importez un fichier de longueur variable, indiquez le séparateur : soit  by tab (tabulation) soit un caractère 
que vous renseignez.  

 
 
Indiquer la position des champs  
La partie Field map vous permet d'indiquer les champs contenus dans les enregistrements du fichier texte. Indiquez 
les positions de chaque champ de votre fichier. Par exemple : 

Vanessa,Claridge,Happy Christmas,26/01/89,img001.tif 

Phyllis,Wills,Holidays are great!,7/5/89,img002.tif 

Andrea,Stratton,Wish you were here,10/2/89,img003.tif 

Dans cet exemple le délimiteur est la virgule. Les champs dont les suivants : 

• Prénom - champ 1  

• Nom - champ 2  

• Un message personnel - champ 3  

• Date de naissance - champ 4  

• Le nom de fichier correspondant - champ 5  

Dans ce cas, vous rempliriez la grille Field map de la façon suivante : 
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Indiquer le champ correspondant 
En important des données textes, NeoPack+ doit savoir comment faire coïncider les champs et les images. 
Il y a deux choix possibles : 

• Liaison sur le numéro, 

• Liaison sur le nom de fichier.  

  
 
Liaison sur le numéro d’image  
Lorsque des images sont importées dans NeoPack+, on leur assigne un numéro. La première image par exemple est 
la numéro 1, la seconde, la numéro 2 et ainsi de suite. Ce numéro doit être présent pour chaque enregistrement du 
fichier texte.  
 
Liaison sur le nom de fichier 
Lorsque des images sont importées dans NeoPack+, le nom de fichier est 
conservé comme étiquette (image tag). Par  exemple, si un fichier importé 
s’appelle ‘film 172.jpg’, son étiquette sera affichée à côté du némoro si vous avez 
choisi l’option Images > show tags.  
Ce nom de fichier doit être présent pour chaque enregistrement du fichier texte.  
 
Fusionner et mettre à jour des données existantes  
Si vous avez déjà importé des données mais que vous voulez les mettre à jour, vous pouvez choisir une des options 
suivante à l’importation : 

• Leave existing details - les textes existants ne seront pas modifiés par la mise à jour,  

• Always replace existing details - les textes existants sont systématiquement remplacés par la mise à jour, 

même si l'enregistrement mis à jour est vide.  

• Replace existing details only if blank - les textes existants sont laissés intacts ; seuls les champs vides sont 

mises à jour avec les nouvelles données,  

• Update existing details - les textes existants sont mis à jour avec les nouvelles valeurs sauf si le contenu du 

fichier est vide. Dans ce cas, les données du job restent intactes.  

 



 

NeoPack + - Créer des jobs dans NeoPack+  Page 91
 

 
Importation des données  
Une fois que la configuration de la boite de dialogue Setup image details text file import est complète, choisissez 
Ok. Assurez-vous que le fichier texte est bien sélectionné puis cliquez sur Open. Les textes sont importés et liés aux 
images correspondantes.  
 

Objets graphiques ‘marqués’ (Tagged graphic objects)  

Les ‘templates’ de NeoPack+ peuvent contenir une image qui apparaît sur le tirage final. Elles sont créées en mode 
Design soit pour un fichier, soit pour un groupe d’images.  
Cela s’avère particulièrement utile si vous souhaiter inserrer un logo d'école ; vous placez alors un objet ‘marqué’ 
dans le ‘template’ qui pointe sur le fichier source du logo.  
 

Créer un champ ‘marqué’ 
Pour inserrer un champ ‘marqué’ dans un ‘template’, il faut d'abord créer un champ graphique qui  contient l’image. 
Il est préférable de créer ce champ directement depuis les options du programme. Allez dans File > Options, 
choisissez alors l’onglet defaut, et Cliquez sur Data fields > Edit. La boite de dialogue Data fields s’ouvre.  
Choisissez l’onglet que vous souhaitez utiliser - soit folder (dossier) soit file (fichier). Nous utiliserons l'exemple du 
logo d'une école.  
 
Créer un champ de fichier graphique (File graphic Field) 
Choisissez l’onglet File, puis cliquez sur Add. Une nouvelle ligne s’ajoute à la liste des champs. Taper le nom du 
champ. Pour notre exemple, entrez  SchoolLogo. Maintenant, cliquez sur la liste de choix  type et sélectionnez 
Graphic dans la liste, puis  Ok. Le champ est maintenant disponible.  

 
 
Ajouter un champ  
Une fois que la champ de fichier graphique a été placé, créez un nouveau fichier par File > New, ou ouvrez un fichier 
existant en passant par  Edit > Fields… pour ajouter le nouveau champ comme au-dessus. Vous devez voir le 
nouveau champ dans la liste des champs disponibles.  

 
Double-Cliquez dans la colonne Value du champ SchoolLogo. La boite de dialogue Open graphic s’ouvre. 
Naviguez pour trouver le logo que vous souhaitez importer.  
 
Importer le fichier  
L’importation se fait comme pour une image traditionnelle. A l’importation, une vignette s’affiche dans le panneau 
Graphic Value. NeoPack+ peut conServeur un lien vers le fichier de plusieurs façons :  

• Remember the actual path of the file – mémoriser le chemin complet,  

• Discard the path - utiliser les options de recherche de fichier vues dans le chapitre Images.  
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Charger l'image  
Choisissez une option d'importation, puis Select file…. Dans la boite de dialogue sélectionnez le fichier, son moyen 
de localisation, puis Open.  

 
 
Choisir un champ transparent  
Deux types de masque peuvent alors définir un champ transparent.  
 
Masque transparent simple  
Si votre logo possède des champs transparents, cliquez dessus dans la preview. Le champ transparent apparaît alors 
quadrillée. Pour supprimer une champ, ciquez sur No Mask.  
 

# Dessinez votre logo soigneusement, car toute partie ayant la même couleur que le champ transparent sera 
aussi transparent. Faites particulièrement attention aux bords du logo. Si ils sont trop clairs, ils vont avoir 
tendance à se transformer en halo sur le tirage final. Cela arrive particulièrement avec les fichiers JPEG. 
Utilisez donc plutôt les formats BMP ou PNG.  

 
Utilisation d'un masque transparent  
Les masques de 8 bits permettent des effets plus harmonieux. Pour placez ce type de masque, cliquez sur  Mask 
file… Une boite de dialogue s'ouvre. Choisissez  Load, puis sélectionnez votre fichier et finissez par Open. Le 
masque chargé s’affiche. Vous avez la possibilité d’appliquer une rotation ou une symétrie à votre masque. 
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Une fois que votre masque est correctement configuré, choisissez Ok. La boite de dialogue se ferme, et le nom du 
fichier sélectionné apparaît dans le champ Details mode.  
Faites de même pour chaque masque. Les nouveaux champs sont maintenant disponibles.  

 
 
Assigner les détails multiples  
Vous pouvez associez ces champs à plusieurs images. Ce qui est utile si vous travaillez par groupe par exemple. 
Sélectionnez toutes les images qui doivent recevoir un même logo, puis cliquez sur le champ Details que vous 
souhaitez associer. Entrez alors une valeur ou choisissez un logo.  

 
 

Formation des ‘pages’  
La formation des jobs se fait en choisissant une image, puis un ‘template’. Vous pouvez alors ajouter un Item et un 
texte. Le choix d’un ‘template’ peut se faire de plusieurs façons :  

• Sélection manuelle à l'aide de la souris ou du clavier,  

• Sélection en utilisant un lecteur de code barre,  

• Importation depuis un fichier texte contenant les informations de commande. 

 
Créer les jobs manuellement  
Un ‘template’ peut être associé à une ou plusieurs images, puis à un Item. Sélectionnez un ‘template’ depuis la 
fenêtre Pack add/view. Lorsque vous créez un ‘template’, vous pouvez leur affecter un raccourci clavier.  
 
Associer un ‘template’ aux images  
Vous pouvez associer un ‘template’ à une ou plusieurs images à la fois. Pour cela, vérifiez d’abord que la bonne file 
d’attente est sélectionnée dans la liste déroulante (Queue), puis sélectionnez les images à utiliser. Servez-vous de la 
souris ou des raccourcis Windows :  

• < Shift > Click la première puis la dernière image - sélectionne un bloc d’images.  

• < Ctrl > Click chaque image – ajoute les images à la séléction une par une. 

 
Une fois que vous avez sélectionné vos images, cliquez sur le bouton  Pack Layout dans la fenêtre des  Packs ou 
appuyez sur son raccourci clavier. Notez qu’une préview du pack s’affiche et que les images sélectionnées sont 
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ajoutées à la file d'attente (fenêtre Queue). Pour ajouter un Item aux images sélectionnées, cliquez sur un bouton 
Item ou appuyer sur son raccourci clavier. Notez que l’Item est adapté sur les images. 
 
Retirer un Item  
Pour enlever un Item appliqué sur une image, il suffit de la sélectionner, puis d’appuyer sur le 
bouton Remove Design dans l’onglet Items. 
 
Ajouter plusieurs modèles  
Pour associer plusieurs modèles à une image, maintenez la touche Shift enfoncée, et ajoutez un modèle.  
Si vous ajoutez le même modèle, vous pouvez simplement indiquez le nombre d’exemplaire dans le champs de saisie 
Copies. Si vous ajoutez un autre modèle, il sera empilé dans l’onglet Current Packs, et ajouté à la file d'attente.  

 
 

Utilisation d'un lecteur de code barre  
Vous pouvez créer vos jobs à l’aide d’un lecteur de code barre, si cette information existe quelque part. Par exemple, 
vous pouvez avoir le numéro d’image et les informations de commande imprimés sur une carte que doit vous 
renvoyer le client.  
 

# Lorsque vous travaillez avec des codes barre, il est très important que vos raccourcis soient uniques. 
Sinon, aucun modèle ne sera sélectionné.  

# Si un raccourci est attribué à un modèle par  Edit > Pack set, il sera prioritaire sur tout autre raccourci 
défini dans les propriétés en mode Template Designer. 

 
 
Les Commandes sont formées en utilisant le panneau Find dans l'application principale. Les informations demandées 
sont : 

• Le numéro d’image ou le nom de fichier,  

• Le modèle,  

• L’item s'il y a lieu  

 
Pour créer une commande, choisissez  le numéro d’images, puis cliquez dans le cadre Find image. Lire 
le code barre contenant le numéro de l’image. L'image devient active dans la liste. Notez que le curseur 
avance dans le champ de saisie suivant.  
Ensuite, lire le code contenant le modèle. Celui-ci est ajouté à la file d'attente.  
Pour finir, lire le code barre contenant l’item. Il s’applique automatiquement au tirage.  
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Importation d'un fichier texte  
Si vos commandes sont stockées dans un fichier texte, vous les importez et créez le job automatiquement. Comme 
pour les codes barre, la commande est créée en utilisant les raccourcis associés aux modèles. Il est donc important 
que ces raccourcis soient bien définis pour que l'importation fonctionne convenablement.  
 
Sélectionner le fichier texte  
Ouvrez le fichier que vous souhaitez utiliser puis choisissez  Queue > Import text file… La boite de dialogue Text 
file to import queue s'ouvre. Sélectionnez votre fichier de commande, et cliquez sur Ouvrir.  
 

Configurer l'importation  
Dans la boite de dialogue Text file to import queue, cliquez sur Setup. La boite de dialogue est 
divisée en plusieurs parties : 

• Type - indique le format de fichier que vous importez,  

• Field positions - vous permet d'indiquer la position des champs,  

• Match on – Choisissez la correspondance par le numéro des images ou par le nom de 

fichier. 

 
Choisissez le type  
Il y a plusieurs formats de données que vous pouvez utiliser. Ils vous permettent de délimiter les champs. Ceux sont 
les suivants : 

• Longueur fixe - chaque champ a une longueur fixe,  

• Longueur variable – la fin de chaque champ est indiquée par un délimiteur.  

 
Choisissez le format du fichier que vous préférez.  
 
Longueur fixe  
Si vous importez un fichier de longueur fixe, indiquez la position de chaque champ dans le fichier. 

  
 
Longueur variable  
Si vous importez un fichier de longueur variable, indiquez le séparateur : soit  by tab (tabulation) soit un caractère 
que vous renseignez.  
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Indiquer la position des champs  
La partie Field map vous permet d'indiquer les champs contenus dans les enregistrements du fichier texte. Indiquez 
les positions de chaque champ de votre fichier. Par exemple : 

• img001.tif,A,Q,2 

• img002.tif,A,Q,1 

• img003.tif,A,W,3 

est l’exemple d'un fichier à longueur variable séparé par virgule. Les positions des champs sont : 

• Champ 1 nom de fichier images,  

• Champ 2 raccourci de modèle,   

• Champ 3 item, 

• Champ 4 quantités.  

 
La fenêtre ressemblerait donc à : 

 
 
Indiquer le champ correspondant 
En important des données textes, NeoPack+ doit savoir comment faire cohincider les champs et les images. 
Il y a deux choix possibles : 

• Liaison sur le numéro, 

• Liaison sur le nom de fichier.  

 
 
Liaison sur le numéro d’image  
Lorsque des images sont importées dans NeoPack+, on leur assigne un numéro. La première image par exemple est 
la numéro 1, la seconde, la numéro 2 et ainsi de suite. Ce numéro doit être présent pour chaque enregistrement du 
fichier texte.  
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Liaison sur le nom de fichier 
Lorsque des images sont importées dans NeoPack+, le nom de fichier est conservé 
comme étiquette (image tag). Par  exemple, si un fichier importé s’appelle ‘film 
172.jpg’, son étiquette sera affichée à côté du numéro si vous avez choisi l’option 
Images > show tags. Ce nom de fichier doit être présent pour chaque 
enregistrement du fichier texte.  
 
Formation des jobs  
Une fois les champs crées, choisissez Ok. Maintenant, assurez-vous que le fichier texte est bien séléctionné, et 
choisissez Ouvrir. La file d'attente se créée à partir des données du fichier.  
 

Contrôle de la file d'attente  
Lorsqu’une image est associée à un modèle et qu’elle apparaît dans la file d’impression, on lui joint un statut. Celui-
ci est visible dans le coin inférieur gauche de chaque preview de modèle.  
 

Action procédure statut 

Créer ou ré-imprimer un pack Ajouter le pack ou sélectionner Queue > Reprint 
selected packs  

Impression d’un ou plusieurs packs Choisir la commande File > Print 
 

Bloquer un ou plusieurs packs Choisir Queue > Hold selected packs 
 

Libérer un ou plusieurs packs bloqués Choisir Queue > Release selected packs 
 

 

Trier la file d'attente  
Vous pouvez trier les packs affichés dans la file d'attente par ordre croissant ou par statut. Pour trier par : 

• Image : Choisissez Queue > Sort by image,  

• Statut d’impression : Choisissez Queue > Sort by printer status. 

 

Retirer un pack d'une file d'attente  
Vous pouvez supprimer un ou plusieurs packs de la file d’attente en sélectionnant,  Queue > Remove selected.  
Un ensemble de packs peut être sélectionné soit : 

• En maintenant la touche <Shift> enfoncée, et en cliquant sur le premier puis le dernier pack, soit  

• En maintenant la touche <Ctrl> enfoncée et en sélectionnant plusieurs packs.  

 

Statistiques  
Des statistiques sont disponibles pour une file d'attente. Pour les visualiser, choisissez 
Queue > Statistics.  
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11 
Gestion de la couleur  

 
La plupart des imageur modernes tirent profit de la gestion ICC des couleurs. ICC se base sur une série de profils 
couleurs fournis par un constructeur ou un prestataire. Dans un système de gestion de la couleur ICC, chaque 
périphérique posséde ses caractéristiques et son propre espace couleur. Votre écran affiche alors une image très 
proche de ce que sera votre sortie. 
NeoPack+ utilise le système ICM-2 de Microsoft développé sous Windows 2000. La gestion de la couleur n’est 
utilisable que sous Windows 2000.  
 

Profils Couleurs  
Chaque périphérique traite les couleurs suivant ses propres caractéristiques. Un moniteur a tendance à afficher des 
images plus contrastées qu’une épreuve papier. Sans calibration, un système de production numérique peut donc 
donner des résultats imprévisibles. 
La gestion couleur ICC se base sur des profils couleurs pour s'assurer que des images sont reproduites fidèlement. La 
précision d’un système de gestion des couleurs repose donc sur la qualité de ces profils, en particulier ceux des 
sytèmes d’impressions. En utilisant des profils approximatifs, vos résultats risque d’être imprévisibles. 
 
Types de profil  
Il y a plusieurs types de profils couleurs : 

• Le profil d’entrée caractérise les scanners, les appareils photo numériques et plus généralement tout capteur 

digital, 

• Le profil écran caractérise un moniteur, qu’il soit CRT, LCD ou d’un autre type,  

• Le profil de sortie caractérise un périférique de sortie (comme un traceur jet d'encre, un CRT Xerox ou un 

système d’impression quadrichrome. 

 
En général, le constructeur fournit un profil couleur générique adapté à un périphérique particulier. Mais parfois, 
vous obtenez de meilleurs résultats en produisant vos propres profils, car ils sont personnalisés pour chaque 
périphérique de votre laboratoire.  
Il existe des outils permettant de créer des profils couleurs. Les plus connus sont : 

• Agfa FotoTune – c’est un outil qui créé des profils d'entrée, d’écran et de sortie,  

• X-Rite – ensemble d’outils (logiciels, sonde, etc …) qui crééent des profils d’écran et de sortie. 

Consultez les documentations fournies par vos fournisseurs pour connaître la meilleure façon de calibrer vos 
périphériques.  
 

ICC color workflow  
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L’ICC color workflow décode les caractéristiques colorimétriques de vos images depuis le document original (soit 
un film couleur scanné, soit un fichier numérique issu d’un boitier digital) jusqu’à l’impression finale en passant par 
son affichage à l’écran. Dans un système bien géré, les images affichées sur un moniteur sont très proches, aussi bien 
de la scène initiale que de la sortie finale.  
 
Scanners  
Les scanners capturent les images présentent sur un support opaque ou transparent. Une image positive  (papier ou 
film) est simple à profiler, car il est possible d’utliser notre œil comme repère visuel. Un négatif couleur par contre 
représente le stade intermédiaire vers un tirage papier. Il existe donc un certain nombres de variables qui 
interviennent dans son interprétation – le support, le matériel d’impression, les produits chimiques utilisés , etc … 
Ceci explique qu’il soit si difficile d’associer un profil à un film négatif couleur.  
 
Moniteurs  
Les moniteurs couleurs ont des outils de calibrations qui permettent de contrôler la façon dont vont être affichées les 
images. Il existe également des outils et des périphériques d'étalonnage qui autorisent la création de profils – du 
logiciel Adobe Gamma loader jusqu’aux periphériques de mesure X-Rite. Utiliser un périphérique de meusure 
permet d’obtenir des profils plus précis, cependant les logiciels offrent des résultats acceptables.  
 
Périphériques de sortie  
Il existe plusieurs types de périphériques de sortie - du jet d'encre, en passant par le CRT, jusqu’aux presses CMJN. 
Il faut calibrer ces périphériques avec une grande exactitude. Ils exigent l’utilisation d’outils de mesure spéciaux. 
Ceci explique pourquoi dans la plupart des cas, les fabricants fournissent un profil.  
 

Construire le système de gestion ICC 
L'installation du Color Workflow implique de connecter tous les périphériques engagés dans la chaîne, puis de leur 
associer un profil. Il faut aussi s’assurer de leur entretien régulier et de la mise à jour des profils. 
 
Associer des profils couleur  
NeoPack+ dispose d’un grand nombre d'options d'impressions. Vous pouvez choisir, soit d'imprimer en utilisant un 
driver Windows NT, de créer un fichier bitmaps ou d’utiliser un ‘Print Job File’ de Timestone.  
Timestone Software a développé des drivers Windows NT pour certains imageurs du marché, et NeoPack+ tire 
avantage de ces drivers ‘maison’. 
Si votre driver n’existe pas, vous avez toujours la possibilité de sortir des fichiers bitmaps, que vous enverrez ensuite 
vers l’imageur. 
L’utilisation des Print Job Files permet à NeoPack+ de bénéficier d’une architecture d’impression distribuée. Ce 
système réduit au maximum le temps d’attente durant l’impression d’un ‘job’ et permet ainsi d’assurer une chaîne de 
production fluide et constante.  
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Impression 

  
Choisir l'imprimante  
Avant d'imprimer un ‘job’, vous devez choisir le procédé d'impression. Les options d'impressions sont situées dans la 
boite de dialogue Printer Setup. Ouvrez cette boite dialogue après avoir ouvert un ‘job’ à  imprimer, puis choisissez 
File > Print setup.  
 
 
 

Choisissez la méthode d'impression  
 
 

Déterminez les options d'impression  
 
 

          Déterminez la taille du papier  
 
 
Déterminez les options de coupe et de cadrage  
 
 

Déterminez les options de nommage des fichiers  
 
 
  
 
 
 

Choisir le procédé d'impression  
Il y a trois options d’impression dans NeoPack+ : 

• Impression vers une imprimante Windows,  

• Impression vers un fichier Bitmap, 

• Impression vers un Print Job File.  

 
Choisissez une de ces méthodes.  
 
Imprimer vers un Print Job File 



 

 

Il y a peu de chose à faire dans ce cas hormis d’entrer le chemin d’accès au dossier cible. Choisir ce mode 
d’impression désactive toutes les autres options d’impressions exceptée l'option Align. Nous détaillerons cette option 
plus loin dans ce chapitre.  
Une fois sélectionnée, cliquez sur Ok. La boite de dialogue Print Setup se ferme. Pour imprimer le ‘job’, choisissez 
file > print. Indiquez quels fichiers doivent être imprimés puis le chemin où Timestone écrira le Print Job File. Vous 
pouvez choisissez soit d’entrer le chemin au clavier soit de cliquez sur  Browse et de sélectionner un dossier à la 
souris.  
Cliquez sur Ok pour lancer l’impression.  

 
 
Imprimer vers une imprimante Windows  
Vous pouvez imprimer en utilisant un driver d’imprimante Windows depuis NeoPack+. Cela permet entre autre de 
sélectionner la taille et l’orientation du papier.  
Pour choisir ce mode, cliquez dans la case Windows printer, puis sélectionnez l'imprimante que vous souhaitez 
utiliser dans la liste déroulante. Les options d’impressions sont alors accessibles via la bouton Properties. Pour de 
plus amples informations sur les options d’impressions disposibles sur votre périphérique, consultez la 
documentation du constructeur.  

 
 
Imprimer vers un bitmap  
NeoPack+ permet de sortir des fichiers bitmaps directement en choisissant  bitmaps files dans la fenêtre Print to. 
Une fois que l’option est sélectionnée, le bouton Setup devient actif. Cliquez dessus pour entrer dans les options.  
 

# Lors d’une impression vers un fichier bitmap, tous les repères de coupes ‘hard’ sont pris en compte, et 
plusieurs fichiers sont créés en fonction du nombre de repères.  

 
 
Choisir la résolution et le format de sortie  
Choisssez la résolution de sortie en cliquant sur la liste déroulante DPI. Vous avez le choix entre plusieurs formats de 
fichiers de sortie tape. Pour en sélectionner un, cliquez sur la liste déroulante format.  
 
Fixez une correction de couleur  
Vous pouvez choisir un réglage de LUT en cliquant sur la liste déroulante Apply LUT. Pour plus d'information sur 
les LUTs se réferrer au chapitre 12.  
Ajouter de la netteté  



 

 

Vous pouvez appliquer une correction de netteté en renseignant les champs Sharpen. Choisissez le Kernel et le 
Strength.  
 

# Vous pouvez laisser le Kernel à 3. Mais il faudra tester la valeur de Strength.  

 

 
 

Renseigner les options de nommage des fichiers  
Il y a plusieurs options lorsque vous imprimez vers un bitmaps. Vous n’avez accès à cet onglet qu’une fois que 
l’option  Bitmap file est sélectionnée.  
Le format de fichier est le suivant : 

[Prefixe][Nom][Exemplaire]. [ext]  

• [préfixe] - chaque fichier commencera par une chaine de caractère,  

• [Nom] - le nom de fichier repris à l’impression,  

• [Exemplaire] - le nombre d’exemplaire à imprimer, 

• [ext] - l'extension du fichier  

 
 
Vous pouvez indiquer quel nom utiliser en cliquant sur  for # use et en sélectionnant une des trois options 
disponibles : 
 

Option Détail 

Image No. 
NeoPack+ utilise le nombre associé à l’image pour nommer le fichier. S’il existe plusieurs 
packs à imprimer par image, le nombre est suivi d’un chiffre séquentiel indiquant de quel 
pack il s’agit. 

Original image tag 
NeoPack+ utilise l’étiquette de l’image pour nommer le fichier. S’il existe plusieurs packs 
à imprimer par image, le nombre est suivi d’un chiffre séquentiel indiquant de quel pack il 
s’agit. 

Sequential No. 
NeoPack+ créé ses propres numéros séquentiels pour nommer les fichiers. S’il existe 
plusieurs packs à imprimer par image, leur nom sera créer de la même manière que les 
autres. 

 
Une fois que les options sont remplies, choisssez Ok.  
 
Indiquer le chemin de sortie  
Pour imprimer le ‘job’, choisissez  file > print. Indiquez quels fichiers doivent être imprimés puis indiquez le chemin 
où Timestone doit écrire le Bitmap. Vous pouvez choisissez soit d’entrer le chemin au clavier soit de cliquer sur 
Browse et de sélectionner un dossier à la souris.  



 

 

Choisissez Ok pour imprimer.  
 

# Si vous avez choisi  Sequential number comme option d’impression dans la liste de choix  for # use, 
vous pouvez sélectionner le premier numéroà utiliser. Entrez ce nombre dans le champ Next sequential 
number.  

 
 

Impression vers une imprimante Windows  
Il existe un certain nombre d’options qui vous permettent d’automatiser vos impressions dans NeoPack+. Ces 
options sont : 

• Printer Properties – configuration de l'imprimante,  

• Printer output options - choisir d’imprimer vers un fichier ou vers une imprimante,  

• Paper size selection – automatiser les formats de papier, 

• Alignment and cut marks - comment l'image imprimée est alignée et si les repères de coupes sont appliqués 

ou pas. 

 
Fixer les propriétés de l'imprimante  
Après avoir sélectionné une imprimante, vous pouvez configurer ses propriétés en cliquant sur  Properties dans la 
boite de dialogue Print setup. Les options qui s’affichent ici dépendent du votre pilote d’impression. Consultez la 
documentation du constructeur pour plus d’informations.  

 
 
Entrer les options de sortie  
Il y a un certain nombre d'options disponibles lorsqu’on utilise un driver Windows NT.  

• Print to file - crée un fichier Windows .PRN pour une utilisation ulterieure,  

• Individual file for each page – à sélectionner seulement si vous utilisez le driver Zenographics SuperPrint,  

• Separate pages (don’t batch)  - si il y a plusieurs pages, l’impression ne commence qu’une fois que le ‘job’ 

entier a été préparé. Par ce choix chaque page est envoyée individuellement à l'imprimante. Ce qui signifie 

que chaque page commence à s’imprimer dès que le job est prêt. En imprimant de cette façon, il est possible 

que des jobs soient mélangés si plusieurs personnes impriment en même temps.  



 

 

 
 

Sélection du format de papier automatique  
NeoPack+ peut désigner automatiquement la taille de papier la plus adaptée pour une image. Dans le job, il peut y 
avoir plusieurs tailles différentes. Par exemple le pack A peut avoir une taille de de 8 x 20.5", alors que le pack B ne 
fait que 8 x 11.5". Imprimer ces modèles sur un même format de papier provoque de la gache. NeoPack+ a les 
moyens de choisir automatiquement parmis les formats de papier disponibles par défaut, ou de générer le format 
exact.  
 
Utiliser les tailles par défaut  
Une fois choisi dans la boite de dialogue de propriétés d'imprimante, le format de papier est utilisé.  
 
Sélectionner parmis les formats de papier disponibles  
Choisissez File > Print setup… La boite de dialogue Print Setup s’affiche. La sélection automatique du format de 
papier parmis ceux disponibles se fait en choisissant l’option Pick best paper size. NeoPack+ contrôle alors tous les 
formats disponibles, et choisit le plus proche de l’impression en cours. Cette vérification est appliquée à chaque 
‘job’, donc une file d'attente peut contenir plusieurs formats ; le meilleur format est conservé à chaque fois.  
 
Utiliser des formats papier particuliers uniquement (custom paper sizes only)  
La plupart des travaux produits par NeoPack+ ne correspondent pas à des tailles standard (A4, letter, etc …). Le 
driver d’imprimante vous autorise à créer vos propres tailles de papier qui coïncident exactement aux formats de 
NeoPack+. Dans ce cas, il vaut mieux ne pas laisser l’application choisir une taille standard qui ne correspondra peut 
être pas.  
Choisissez  Use custom paper sizes only, pour que NeoPack+ ne prennne en compte que les formats que vous avez 
définis et choisis.  
 
Cut to size (couper à la taille) 
En utilisant un driver d'imprimante Timestone, l’option Cut to size fixe automatiquement l’avance papier 
correspondant à l’impression. Vous n’avez pas besoin de définir de format de papier, le driver d’imprimante le fait 
tout seul.  

 
 

Alignement et repères de coupe  
Vous pouvez choisir d'imprimer vos travaux sur du papier plus large que l'image. Et dans ce cas vouloir centrer 
l’image dans la feuille. Vous pouvez également appliquer ou non les repères de coupe.  
 
Aligner  
Pour contrôler la position de votre image dans la feuille, utilisez la liste de choix align. Ca n’est utile que si la feuille 
est plus grande que l'image.  
 
Appliquer les marques de coupe  
Si les ‘templates’ ont des repères de coupes, vous avez le choix de les ignorer en décochant la case Honour cut 
marks. En cochant la case, les coupes sont actives. 

 



 

 

 

Imprimer les pages  
Une fois toutes ces options définies, choisissez  File > Print. La boite de dialogue d'impression s'ouvre. Les images à 
imprimer peuvent être choisies en utilisant la partie Print what.  
 

Choix Impression… 

All La totalité du job 

Un-printed only Les images du job qui n’ont pas encore été imprimées 

Selected only Les images du job qui sont sélectionnées dans la file d’attente 
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Calibration  

 
La calibration de NeoPack+ permet d’obtenir des impressions conformes et prévisibles. Si le système ne l’est pas, 
vous ne pouvez pas quantifier les couleurs et la densité ; vos résultats deviennent fluctuants.  
L'étalonnage du système se fonde sur le maintien sous contrôle de chaque périphérique dans la chaine de production. 
Certains périphériques (en particulier les imprimantes) disposent de plus ou moins de moyens de contrôle. NeoPack+ 
dispose d’éléments permettant le réglage des périphériques d'entrée et de sortie.  
Il est cependant recommandé de calibrer ces périphériques avant d'utiliser les fonctions de NeoPack+. L’application 
autorise l'étalonnage par une série de LUTs ou d’une table de courbes. Chaque périphérique de votre chaîne de 
production peut être plus lumineux, plus dense, ou d’un contraste différent. Cela signifie qu’une image imprimée 
correctement sur un imageur ne le sera pas forcément sur un autre. De même, les images provenant d'une source 
donnée, peuvent être plus claires ou plus foncées que selles issues d'une source différente. Les écrans affichent aussi 
les images de façon légèrement différentes.  
Par une approche logique, chacune de ces différences peut être identifiée et corrigée en utilisant les LUTs.  

Environnements de calibration  
Il y a deux types de chaines de production : 

• Monoposte et imprimante unique,  

• Multiposte et/ou plusieurs imprimantes  

 
Dans un environnement où une station de travail fonctionne avec une seule imprimante, l'étalonnage devient plus 
facile. Le travail est évidemment plus complexe si vous disposez d’un réseau connécté à plusieurs imprimantes. 
Cependant, dans ces environnements multiples, il est important de sélectionner un périphérique comme étant la base.  
Il y a plusieurs points communs entre ces deux environnements.  
 

Contrôler l'imprimante  
La première chose à faire est de contrôler l'étalonnage de l'imprimante. Suivez la procédure d'étalonnage fournie par 
le constructeur.  
NeoPack+ vous fourni une charte d'impression. Imprimer cette image en utilisant les options de l’imprimante par 
défaut.    
Imprimez la charte sur chaque imprimante de votre chaine de production.  
 

Interprétation de la charte  
La charte a trois zones importantes : 

• Le dégradé de gris,  

• Le point blanc, les hautes lumières, les basses lumières et le point noir,  

• Une image pour une confirmation visuelle.  



 

 

 

 
 
 

Zones de calibration des hautes lumières 

 

 
Zones de calibration des ombres  Dégradé de gris 
 
Le dégradé de gris  
Le dégradé de gris est l'élément le plus important de la charte. Il doit être constant du noir au blanc, sans zone 
colorée et sana cassure. Si une zone colorée apparaît alors que le reste est neutre, vous devez relancer à la procédure 
d'étalonnage de l'imprimante. Ce problème ne se règle pas facilement avec les réglages de NeoPack+, et doit être 
corrigée sur l'imprimante. Lorsque une imprimante est dans cet état, c'est un problème de linéarité.  
 
Les ombres et les hautes lumières  
Les ombres et les hautes lumières rendues sur la charte permettent de connaître les qualités de détail de l’imprimante. 
Dans la théorie, il doit y avoir une différence entre chaque niveau de gris. Dans la pratique, seuls les carrés affichent 
des écarts. Cela sera corrigé plus tard.  
 
L'image visuelle  
L'image permet d’avoir une idée plus précise des performances de votre imprimante. Les zones qui présentent un 
interrêt sont : 

• Un fond gris chiné. Si votre imprimante n'est pas linéaire, vous verrez apparaître des bandes colorées.  

• Les parties claires donnent une idée du rendu des hautes lumières. Votre imprimante peut ne pas bien rendre 

les détails.  

• Les parties sombres donnent une idée du rendu des basses lumières.  Votre imprimante peut ne pas bien 

rendre les détails.  

 

Comparer les imprimantes  
Si vous travaillez avec plusieurs  imprimantes, imprimez l'image sur chacune d’entre elles, et comparez les résultats 
en positionnant les tirages côte à côte. Notez les différences.  
 

Calibrer un moniteur  
Une fois que les imprimantes sont calibrées, passez à la calibration des écrans.  
 
Éclairage de la pièce  
Il vaut mieux avoir des conditions d’éclairage neutres. Si l'éclairage dans la pièce change brutalement pendant la 
journée, vous aurez l’impression que l’affichage des images change également. Les conditions d’éclairage doivent 
être contrôlées.  
 
Les outils de calibration  
Certaines cartes vidéos permettent  de modifier le gamma dans le panneau de configuration  Affichage. Dans tous les 
cas, suivez la procédure recommandée par le constructeur. Selectionnez un gamma de 2.2.  



 

 

Vous devrez toujours lancer l’assistant de calibration de NeoPack+ pour confirmer la configuration.  
 
Calibration d’écran et Adobe Photoshop  
Si vous possèdez Adobe Photoshop, et que vous comptez l'employer pour modifier des images, il est important de 
bien configurer le programme.  
 

# Si vous utilisez Photoshop 5.0 ou une version plus récente, il est important de désactiver la gestion des 
couleurs. Sinon il risque de modifier involontairement les couleurs des images.  

 

L’assistant d'étalonnage du moniteur  
Choisissez  Options depuis le menu File. Puis l’onglet LUT. Vérifiez que la case Enable monitor LUT est cochée.  

 
Cliquez sur calibrate pour lancer l’assistant d'étalonnage.  

 
Choisissez Next pour commencer la procédure d'étalonnage, ou Cancel pour l’annuler.  

 
Beaucoup de moniteurs possèdent des commandes intégrées de gestion de la couleur. Le plus courant consiste à 
choisissez entre plusieurs températures de couleurs. Sélectionnez 9300K. Si votre écran autorise la balance des 
couleurs manuelle, vous pouvez l’utiliser si vous le souhaitez. Modifiez les réglages du moniteur jusqu’à ce que la 
fenêtre grise paraisse neutre.  
Cliquez sur Next pour passer à l’étape suivante.  



 

 

 
Montez le contraste au maximum. Ensuite, cliquez sur le bouton Full Scren pour ajuster la luminosité. L'écran de 
gestion de la luminosité s’affiche en plein écran. 

 
Ajuster le contrôle de luminosité jusqu'à ce que vous puissiez distinguer le cercle central. Si vous apercevez le carré 
à gauche du cercle, l'écran est trop lumineux.  
Une fois que vous êtes satisfait de votre réglage, cliquez sur le bouton en bas à droite de l'écran pour revenir à 
l’assistant.  
 

# Si vous modifiez les réglages de contraste ou de luminosité après cette étape, vous devrez exécuter à 
nouveau l’assistant de calibration. Si l’écran dispose de commandes digitales, scotchez-les pour qu’on ne 
puisse pas les modifier ! 

 

 
La prochaine étape consiste à ajuster le curseur jusqu'à ce que la zone centrale ne soit plus visible. Les meilleurs 
résultats sont obtenus en se tenant à 1 mètre environ du moniteur, et en dé-focalisant vos yeux. Déplacez chaque 
curseur jusqu'à ce que la zone centrale ne soit plus visible.  



 

 

 
Choisissez le gamma de votre moniteur. En général, il s’agit de 2.2, mais vous pourrez le changer plus tard.  

 
Cliquez sur Finish pour terminer l’assistant. Cancel ferme l’assistant sans appliquer de changements.  
Pour finir, choisissez Ok dans La boite de dialogue Options. Notez que l’affichage des images peut changer, du fait 
de l’étalonnage.  
 
Ce qui a été réalisé ? 
En exécutant l’assistant d'étalonnage, le point noir et le point blanc ont été ajustés, et le gamma du moniteur a été 
déterminé.  
Ce qui signifie qu’une même image peut être affichée sur plusieurs moniteurs qui ont été calibrés de la même façon, 
et  apparaître de la même manière sur chaque.  
 
A quel moment exécuter l’assistant  
L’assistant doit être exécuté : 

• Dés qu’un réglage du moniteur est modifié,  

• Si les utilitaires d'étalonnage sont changés,  

• Si l'éclairage de pièce change de façon considérable,  

• Tenir compte du vieillissement de moniteur.  

 

Calibration de l'imprimante  
Des corrections existent pour certaines imprimantes, et sont disponibles dans la boite de dialogue Print Setup.  
 

Construire une correction sur une imprimante  
Choisissez Print Setup depuis le menu File



 

 

 
Cliquez sur         . La fenêtre de LUT s'ouvre.  
 

 
 
 
 
 

Différents modes LUT 

Courbe de visualisation 

Liste des LUTs disponibles 

 
Outils de construction de LUT 
 
 

 
Il y a trois parties interressantes : 

• La liste des LUT disponible,  

• Les outils de construction de LUT,  

• Commutateurs de modes LUT.  

 
Créer un nouveau LUT  
Choisssez New. Une nouvelle ligne apparaît dans la grille. Entrez un nom.  
 
Modes LUT  
Il y a plusieurs types de LUT. Les plus communs sont : 

• Basic,  

• Avançé.  

 
Il y a d'autres modes disponibles en utilisant les boutons de commutateur de mode               . Ils doivent seulement 
être utilisés par des personnes expérimentées.  
Changez de mode LUT en choisissant basic/adavanced.  

 
 
Créer un LUT basic  
Un LUT de base permet : 

• Un gamma global,  

• Un gamma rouge, vert ou bleu spécifique,  

• Un point noir et un point blanc manuel.  



 

 

 
Choisissez un gamma  
Choisissez la valeur de votre gamma soit en utilisant le curseur, soit en entrant une valeur à la main. La courbe 
interprète le nouveau LUT.  
Choisissez un gamma pour un couleur spécifique en choisissant une couleur dans la barre d’outils, et en lui 
appliquant un gamma donné.  
 
Choix d'un point noir et d’un point blanc  
Vous pouvez les choisir en déplaçant le curseur, ou en entrant une valeur. La courbe change en fonction de la valeur 
choisie.  
Vous pouvez vouloir changer le point noir ou blanc à partir d’une image qui a mal été imprimée. Photoshop vous 
permet de vous rendre compte visuellement de ce problème. Si le Pixel le plus foncé a une valeur superieure à zéro, 
et le plus clair une valeur inférieure à 255, vous pouvez chercher à ajuster ces valeurs.  

 
Un LUT est construit en choisissant la valeur gamma exigée, soit avec le curseur, soit en entrant une valeur.  
 
Créer un LUT ‘avançé’  
Un LUT avançé permet : 

• La correction gamma globale,  

• La configuration du point noir,  

• La configuration du point blanc,  

• La correction des ombres,  

• La correction des hautes lumières. 

 
Si vous voulez éclaircir les ombres, ou obscurir les hautes lumières, ou même saturer les couleurs dans les ombres et 
les hautes lumières, les outils avançés du LUT vont seront très utiles.  
Les réglages disponibles pour la correction du gamma, du point noir et du point blanc sont similaires au LUT de 
base. Les outils supplémentaires concernent les corrections de Gamma ‘high’ et ‘Low’. Lorsque vous les modifiez, 
les ombres ou les hautes lumières sont modifiées. 

  



 

 

Si vous désirez saturer une couleur en particulier, choisissez la couleur dans la barre d’outils LUT, et faites les 
corrections.  
 

Utilisation des LUTs  
Plusieurs LUTs par défaut sont livrés avec le programme. Une fois qu'un LUT a été construit, il est disponible dans 
la liste. Les corrections LUT sont disponibles : 

• A l’importation des images,  

• A l’exportation des images,  

• A l’impression des modèles. 

  

Importation des images avec une correction LUT  
Choisissez  Import from disk… depuis le menu Images. Puis le bouton Setup. Choisissez ou construisez un LUT à 
appliquer lors de l’importation les images.  

 
 

Exportation des images avec une correction LUT  
Choisissez  Export… depuis le menu Images. Puis le bouton Setup.  Choisissez ou construisez un LUT à appliquer 
lors de l’exportation les images.  

 
 

Impression des images avec une correction LUT  
Choisissez Print Setup… depuis le menu File.  Choisissez ou construisez un LUT à appliquer lors de l’impression 
les images.  

 
 

Utilisation d’une l'image de test 
Vous pouvez imprimer une image de test qui vous permet de comparer les imprimantes et les moniteurs. Si après la 
calibration de votre imprimante, cette image sort toujours avec une dominante de couleur, appliquez une des 
corrections suivantes :  
 



 

 

L'image d'essai est… Alors … 

Trop foncée Augmenter le gamma (LUT) de l'imprimante. Par 
exemple, changer le gamma  
de 1.0 à 1.3 

Trop claire Diminuer le gamma (LUT) de l'imprimante 
Trop rouge Diminuer le gamma (LUT) rouge de l'imprimante 
Trop cyan Augmenter le gamma (LUT) rouge de l'imprimante 
Trop vert Diminuer le gamma (LUT) vert de l'imprimante 
Trop Magenta Augmenter le gamma (LUT) vert de l'imprimante 
Trop bleu Diminuer le gamma (LUT) bleu de l'imprimante 
Trop jaune Augmenter le gamma (LUT) bleu de l'imprimante 
 
Si vous calibrez plusieurs imprimantes, sélectionnez en une comme ‘maître’ ou principale, et réglez celle-là en 
premier. Une fois que le système est calibré pour cette imprimante, construisez un LUT qui corrige les différences 
avec les autres.  
Timestone vous livre une image test appellée Calibration.tif qui se trouve dans le répertoire Program 
Files\Timestone Software\ de votre disque dur.  



 

 

 

14 
Bitmaps Compare  

 
En plus de NeoPack+ un petit utilitaire vous est livré : Bitmap Compare. Il permet de charger à l’écran une image de 
référence. La fenêtre est placée au-dessus de NeoPack+, et sert de contrôle visuel. C'est important lorsque vos 
opérateurs travaillent durant des longues périodes devant un écran.  
 

Utiliser Bitmap Compare  
Bitmap Compare ne fonctionne que si NeoPack+ est déjà installé sur la station de travail.  
 
Lancer Bitmap Compare  
Depuis le menu Démarrer, choisissez  Programmes > Timestone Softwares > Bitmap Compare. Bitmap 
Compare est lancé.  
 
Charger l'image de référence  
Choisissez Load depuis le menu File. Une boite de dialogue s’ouvre.  Choisissez l'image que vous souhaitez utiliser 
comme référence. L'image est chargée.  

 

Configurer Bitmap Compare 
Les options permettent de gérer l’échelle d’affichage des images. Choisissez File > Setup. La boite de dialogue 
s’ouvre.  



 

 

  
 
Calibration de l’écran 
Si vous utilisez l'étalonnage du moniteur dans NeoPack+, cochez la case Enable monitor LUT. Il n’est pas 
nécessaire d'exécuter l’assistant une fois de plus, car la configurations actuelle se base sur celle de NeoPack+.  
 
Affichage des images 
Vous pouvez affichez l’image de plusieurs façons. Choisissez l'option qui vous convient le mieux. 
 

Afficher l’image entière dans la fenêtre  
 

L’image prend la taille de la fenêtre mais conserve ses 
proportions. Vous pouvez donc voir apparaître des 
marges grises. 
 

Couper l’image pour remplir la fenêtre 
L’image sera coupée pour prendre tout l’espace 
disponible dans  la fenêtre. Les proportions sont 
conservées. 

Etirer l’image pour remplir la fenêtre La taille de l’image se calibre sur celle de la fenêtre, les 
proportions ne sont plus conservées. 

 
Fenêtre toujours au dessus  
Si vous voulez que la fenêtre apparaîsse toujours au-dessus de NeoPack+, choisissez  Windows always on top. La 
fenêtre sera toujours visible, même si ce n'est pas l'application active.  
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